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Paint can open and create several different file formats, including .bmp, -jpg, and
.gif—everyfile format you need to save graphics for use on a Website.  
Tip: Paint also offers a nifty way to create wallpaper (see page 263). After you create or edit a graphic, choose
FilesSet as Background Tiled) or FilesSet as Background (Centered) to transfer your masterpiece to your
desktop immediately. 

Program Compatibility Wizard
This program is nothing more than an interview-style version of the dialog box de-
scribed on page 120—theonethatlets you trick an older, XP-incompatible program
into believing that it’s actually safely nestled on an old Windows 95 computer, for
example. Fire it up if some older program is giving you grief in XP.

 

Scanner and Camera Wizard

Once your XP-compatible camera or scanneris turned on and hooked up, this com-
mand walks you through the process of downloading photos or triggering the scan.
You'll find more detail on page 202.

Synchronize
You're supposed to use this command in conjunction with the offline Web-page feature
described on page 606.It forces your machine to go downloadthelatest versionsofthe
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“Webssites you've “subscribed”to. (This featureis great for laptop owners who wantto
‘takework homefrom theoffice network, or network domain members wantto keep
“working on documents even if the server that houses them goes down.)
 

Jour Windows XP
"his command gives you a multimedia advertisementfor the new features ofWindows
XP. Try to contain your excitement.

‘Windows Explorer
Seepage 112for details on this navigational tool. 

Vindows Movie Maker
Chapter 7 has the details on this bare-bones video editor.

Think of WordPad as Microsoft Word Junior, since it looks much the same as Word
“(gee Figure 6-6) and createsfiles in exactly the same file format. That’s a great feature if

oudon’t have Microsoft Word, because WordPad lets you open (and edit) Word files
enttoyou by other people. (WordPad can open only onefile at a time, however.)

   

vficrosoft Wordisn’t on your PC, then any icon with thefile extension .doc opens
iitoWordPad when double-clicked.(Ifyou install Microsoft Word, however, it takes

the.doc extension.) WordPadcan also open andcreate plain textfiles, Rich Text
ormiat (RTE) documents, and Microsoft Write documents.

 

  

Figure6-6;
WordPad has menu bars,
toolbars, rulers, andplenty

‘ather familiar Windows

features, Unlike Notepad,
WordPad lets you use bold
anditalic formatting to
enhance the appearance

 
 

 

 
 
 
 

insertgraphics, sounds,
movies, and other OLE
ibjects(see Chapter 5).

  

 
 

Then one day, Jenkins opened the nail to firm s neat littlecentered text:

‘You are twvitedta a Private Ceremony
Sanday, Flay 13

at the Stroke ofMidnight

 

 
CHAPTER 6: THE FREEBIE SOFTWARE

ofyourtext. Your can even Chapter 15: The Beginning of the Beginning
Ik began innocently enough: a few laughs, a little promotional flyer here and
there, But by mid-October, even the tawn hermit had noticed the changes.

 

 
 

  
 
 
 

  
 

 
203

HP Inc.- Exhibit 1007. - Page2217



HP Inc. - Exhibit 1007 - Page 218

Using WordPad
When WordPadfirst opens, you see an empty sheet of electronic typing paper. Just
above the ruler, you'll find drop-down menus and buttonsthataffect the formatting
of your text, as shown in Figure 6-6. As in any word processor, you can apply these
formats (ike bold,italic, or color) to two kindsoftext:

* Text you've highlighted by dragging the mouse acrossit.
° Text you're about to type. In other words,if you click the I button, the next char-

acters you type will beitalicized. Click the I button a secondtime to “turn off” the
italics,

The rightmost formatting buttonsaffect entire paragraphs, as shown in Figure 6-7.

WordPad doesn’t offer big-gun featureslike spell checking,style sheets, or tables. But
it does offer a surprisingly longlist of core word processing features. For example:

* EditFind, Edit—Replace. Using the Find command,you can locate a particular
word or phrase instantly, even in along document. The Replace commandtakesit
a step further, replacing that found phrase with anotherone(a great way to change
the nameofyour main character throughoutan entire novel,for example).

 
Centered Fiigur@ 6-7:

Flush tet|Flush right The rightmost
buttons make

paragraphs flush
left. centered, fush
right, or bulleted as
a list, You can drag

Bulleted  fhrough several
= . paragraphs before

SNCSAaicitintin in clicking these
i butions, or you can

click these buttons

to affectjust the
paragraph where
your insertion point
is already. The
dotted lines in this
illustration indicate

how each press of
the Tab keylines up
the text with one of

the tab stops you
click onto the ruler.

des

tender violent way i  
(Bulleted) (Centered) (Flush right)
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* Indents and Tab stops. As shownin Figure 6-7, you click on the ruler to place Tab
stops there. Each time youpress the Tab key, yourinsertion point cursor jumps in
line with the next tab stop.  

» Object Linking and Embedding,As described in the previous chapter,this feature
(Insert—Object) lets you create or insert a picture, graph, chart, sound, movie,
spreadsheet, or other kind of data into your WordPad document.

» Drag-and-drop editing. Instead of using the three-step Copy and Paste routine
for moving words and phrases around in your document, you can simply drag an
highlighted text from place to place on the screen. See page 164 for details. Bo

Windows XP Games . |

Although the central concept of Windows XP—merging what were once separate
Windowsversionsfor corporations and homes—is a noble andlargely successful one,
a few peculiar juxtapositionsresult. If you're a corporateuser, for instance, you may
wonder what to make of things ike Movie Maker(for editing home movies), Outlook

* Express (a stripped-down,free version of Outlook)—and games. Yes, Windows XP
“even includes eleven gamesfor your procrastination pleasure.

 

-> Moreinterestingstill, several of them let you play against other people on the Internet.
At the Microsoft Game Center (www.zone.com), players from all over the world gather

to find worthy opponents. When you choose one of the Internet-enabled games,
~ your PC connects automatically with this Game Center. An automated matchmaker
~ searches for someoneelse who wants to play the game you chose, and puts the two

- of you together, albeit anonymously.

 
 
 

 
 
 
 

 

 
 

 
 

 

 

|

"The game board that opens, like the one in Figure 6-8, provides more than just the 9 © 07s - |
_ tools to play; there’s even a pseudo-chat feature. By choosing from the cannedlist |
‘of phrases, you can sendlittle game exclamations to your opponent (“Good move,”

» “King mel!”“Bad luck,” and so on). . Po - :

Fip: The ‘ist of utterancesavailable in your chat session is completely canned. For example, you can't typein, eo a
"That was uncalled-for, you sniveling roach!”Still, its canned nature has a virtue ofits own: You can exchange 0. a to
‘platitudes with players anywhere in the world. Your quips show up automatically in the language of your PG a

“= oppenent's capy of Windows, be it Korean, German, or whatever. 

- Here’s the Windows XP complementof games, all of whichare listed in the Start> = |
All Programs—>Games submenu. |

‘ Tip: Completeinstructions iurk within the Help menu of each game.That's fortunate, since the rules of some
~ a these card games can seem elaborate and quirky, to say theleast.  

° FreeCell. You might think of this card game as solitaire on steroids. When you
. choose Game+New Game, the computer deals eight piles of cards before you.
“ The goal is to sort them into four piles of cards—one suit each and sequentially
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from ace to king—in the spacesat the upper-right corner of the screen. (To move
a card,click it once and then click where you want it moved to.) 
You can use the upper-left placeholders, the “free cells,” as temporary resting places
for your cards. From there, cards can go either onto one of the upper-rightpiles
or onto the bottom of one of the eight piles in the second row. However, when
moving cards to the eight piles, you must place them alternating red/black, and
in descending sequence.
 

Fig: When you're stuck, move your cursor back and forth in front of the little king icon at top center. Watch
his eyes follow your arrow as though hypnotized. 

* Hearts, Internet Hearts. The object of this card gameis to get rid of all the hearts
you're holding by passing them off to other players. At the end of each round,all
players counts up their points: one point for each heart, and thirteen pointsfor the
dreaded queen of spades. The winneris the person with the fewest points when
the game ends (which is when somebodyreaches 100).

What makesit tricky is that even while you're trying to ditch your hearts, somebody
else may besecretly trying to collect them.Ifyou can collect all of the hearts and
the queen of spades, you win big-time; everybody else gets 26 big fat points, and
you get off scot-free.

 

  
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 

 

Figure 6-8:
it mayJooklike a simple
game of checkers, but you're
actually witnessing a spec-
tacufar feature of Windows

XP: instantaneous anonymous
internet gaming. Two internet
visitors in search of recreation

have made contact, a game
board has appeared, and the
gameis under way. The Chat
window sits below the game
board. You can even turn Chat

offifyou're planning to play a
cutthroat game and don't want
io fake having friendly feelings
toward your opponent.

EwWwhite has chat turned on, (Beginner,
u are playing as Red.
hite> It’s your turn
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You can play Classic Hearts either against Windows, which conjures up names
and handsfor three otherfictional players to play against you, or against people
on your network, And if you open Internet Hearts, you can play against other
similarly bored Windows PC ownersall over the world.

 

« Internet Backgammon. Thisis classic backgammon,but with a twist: Now you're
playing against people you've never met, via the MSN Gaming Zone.

 
° Internet Checkers.It’s just checkers; once again, though, you can nowplay against

random players on the Internet(see Figure 6-8).

> Internet Reversi. Like Othello, you play this strategy game on a chess-type board
against anotherplayer from the MSN Gaming Zone.

* internet Spades. Here’s yet another card game, again designed for Internet
playing.

* Minesweeper. Under someofthegrid cells are mines; under others, hints about
nearby mines. Your goal: Find the mines without blowing yourself up.

Whenclicking random squares, you run the risk of getting blown upinstantly. If ©
that happens, you lose; them’s the breaks. But if you get lucky, you uncoverlittle
numbers around the square you clicked. Each number reveals how many mines
are hidden in the squares surroundingit. Using careful mathematical logic and the
process of elimination, you can eventually figure out which squares have mines
under them. (To help keep track, you can right-click the squares to plantlittle
flags that mean, “Don’t step here.”} You win if you mark ail the mine squares with
flags.

* Pinball. To start this noisy, animated, very realistic pinball machine (Figure 6-9),
choose Game—New Game.You get three balls; launchthefirst one by tapping the
Space bar, (For a more powerful launch, hold the Space bar down longer before
releasing.)  

Tip: The game becomes a lot more fun whenit fils the screen. Press F4 to makeit so.  

* Solitaire. Here it is: The program that startedit all, the application that introduced
millions of people to the joys of a graphic interface like Windows. (Ask the ad-
vanced-beginner Windowsfan to identify a good program-file code to type into
the Start—+Run dialog box,and he might not know winword or msconfig—buthell
probably know sol.)

 
In Solitaire, the object is to build four piles of cards, one for each suit, in ascend-
ing order (starting with aces). To help achieve this, you maintain seven smaller
stacks of cards in the second row. You can putcards onto thesepiles as long as you
alternate red and black, andas long as the cards go in descendingorder(a four of
hearts can be placed ona five of spades, for example). Click a face-down card on
one of these piles to turnit over. If it helps you to continue the red/black/red/black
sequence you've started, remember you can drag around stacks of face-up cards
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 on these piles. And when you can’t find any more moves to make,click the deck
in the upper-left corner to reveal more cards.

If you win, an animated simulation of what’s exphemistically called “52 Pickup”
appears for your viewing pleasure.   

Tips You can't play Solitaire over the Internet. Even Microsoft hasn’t yet figured out a wayto turn Solitaire
irto a multiplayer game. 

  

Figure 6-9:
Once the Pinball ball is in
orbit around the screen,

you twitch the flippers
by pressing the Z and/
keys. (Put yourpinkies
there—this feels much more

logical than it reads. Even
50, you can reassign these
functions to other keys
by choosing Options
Player Controls.) You can
even “bump the table”by
pressing the X, period. or
up arrow key. 

+ Spider Solitaire. If your spirit needs a good gameofsolitaire, but you just don't
have the time or patience for Solitaire or FreeCell, this kinder, gentler, easter game
may be just the ticket. Thanks to the built-in cheat mechanism, which suggests
the next move with no penalty, you can blow through this game with all of the
satisfaction and noneofthe frustration of traditionalsolitaire games.

You play with 104 cards. You get ten stacks across the top of the screen, and the
rest in a pile in the lower-right corner of the screen. By dragging cards around,
all you have to do is create stacks of cards in descendingorder, from king down
to ace. As soon as you create such a stack, the cards fly off the playing board. The
goal is to remove all of the cards from the playing board.

In the easiestlevel, there’s no need to worry aboutcolor or suit, because the game
gives you only spades. If you run outof imagination,just press the letter M key to
make the program propose a move, accompanied by a heavenly sounding harp

WINDOWS XP PRO: THE MISSING MANUAL
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2 ripple. Andif even the gamecan't find a legal move, simply click the deck in the
~ Jower-right corner to distribute another round of cards, which opens up a new

~ round of possibilities.

” Sticking with the game to the very end delivers an animated confetti/fireworks

oe- display—and a tiny, budding sense of achievement.

‘Everything Else
The.rest of the programs listed in the Start—All Programs menu (at least the ones
“that come with Windows XP)are covered elsewherein this book. Internet Exploreris

éfailed in Chapter 11, Outlook Express in Chapter 12, Remote Assistance in Chapter
_4,and Windows Media Player in Chapter 7.

 

fp:There's much more free Microsoft software availabie to Windows XP gluttons, For example, you'll have
otof fun trying out the popular Powerloys package (programs produced after the operating system's
|éase), the Windows Media Bonuspack, and additional screensavers. You'll find them all here: Attpy//wun

microsoft. com/windewsxp/pro/downloads/default5p. 
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CHAPTER |

/ 
Findows XP is the most advanced version yet when it comes to playing

and displaying multimedia files—photos, sounds, and movies. New fea-
tures makeit easier than ever for your PC to control your digital camera

“©: or scanner, play movies and sounds, andplay radio stations from all over the world ; |
*04, ag you work on your PC (thanks to your Internet connection). :

 
 

In this chapter, you'll find guides to all of these features. oo |

__- Digital Photos in XP wo |
. The new stability of XP is nice, and the new task pane can save you time. But if you

have a digital camera, few of the new features in Windows XP are quite as useful asits
“: ability to manage your digital photos. Microsoft has bent over backwardto simplify
:- and streamline a process that was once a chain of pain: transferring photos from your

*, camera to the PC, and then trying to figure out what to do with them. 
—. Hooking Up Your Camera

~. If your digital camerais less than a few years old, it probably came with a USB cable
designed to plug into your PC. Fortunately,if your PC is young enough to run Win-
‘dows XP, it probably has a USB jack,too.
 
 

 

 
Furthermore, Windows XP comes preloaded with drivers for hundreds of current
camera models, generally sparing you the standardinstallation process described in
Chapter 14. That’s why, for most people, the instructionsfor transferring photos from

-- the camera to the PC are as follows:
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1. Connect the camera to the PC,using the USB cable. That’s it—there is no step 2. As shown in Figure 7-1, Windows XP automatically:
opens the Camera and Scanner Wizard,a series of screens that guides you through.
the process ofselecting and then transferring the photos you want.

 
 
 
  

Note: If hooking up the camera producesthe diaiog box shown at the topof Figure 7-1, then you've installed
some photo-managementsoftware of your own (maybe some that came with the camera). In that case, you.
have a choice: Either select that program to download and manage your photosor click Cancel to let XP do. :
the job as described in these pages. Then open your My Pictures folder GlartMy Pictures) and,at the left o
side of the window,click “Getpictures from camera or scanner.”

 
 
 
 

 

 

Welcome ta the Scanner and Camera
Wizard

PowerShnt 340
This wivandhele you nope patuees fom year Saraora, sGaneey, uf Ahice fe ina COMES, Habe Hebe, ca the ees 
eyow peales, youd oA watch camyoty dees. Pio optinkitJeanremendad fol agyoneod 
To ronlinue, chek Neat

Picture ome and festmationare Piekeos lo Copy Select aname arid dourvationtor your pictures.sures with check marks sil be copied, Ta cetate & pickuns or vigwe ite pugerbes,fickildeed Diges och tie apaiegsiats Dotter
 
 
 

   

  
 

  
Utne Options

ronches koto wetkng ihou pee Completing the Scanner and CarneraWizard

itsduheve boom otafy be pie ena
Yezearsnptorohoatoe
  

Fpicmarefe| vore copied

 Jt an gow cements ov network, chat tbe keaton

=eesentonivatdandd

Tg chaga Inte wikzaud and née pou pasties, lick Firth,

     
 
 

  

 

 
 
 
 
 

Figure 7-9:
Top left: When you con-
nect the camera, you
inay be asked which
editing program you
want fo open.

Top right: Click “ad-
vanced users only” to
work with the camera's

memory card as
theugh it's a disk.

Middle left: The Clear
Alf and Select Aff
butions can save time

when you want to
include, or exclude,
only a few pictures.

Middle right: Windows
offers you the chance
fo create a new

folder for the incoming
pictures, and also
to delete them from
the camereafter the
transfer.

Lowerleft: After the

transfer, Microsoft
invites you to spend
some money.

Lowerright: Click Finish
to open up the folder
that now contains your
pictures on the hard
drive.
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The various screens of the Camera Wizard take you through these steps:

* Welcomescreen. If you're the kind of person whoprefers to let others do your
grant work,just click Next.

Note, however, the “advanced users only”link (Figure 7-1, top right). If you click
it, Windows XP opens up a new folder windowthat shows you the contents of the
camera’s memorycard. Each photois represented as a file icon. At this point, you
can copy these photos to your hard drive by dragging them. Use this technique
if you wantto file them into different folders, for example, rather than using the
wizard to dump them all into a single place.

« Choose Pictures to Copy. On this screen (Figure 7-1, middle left), you can look
over slide-sized versions of the pictures currently on the camera and,by turning
on the checkboxes above them,tell Windows which ones you want to copy to your
hard drive.

Tip: To straighten a photo that's turned 90 degraes, click it and then click one of the twotiny Rotate buttons
” at the iower-jeft comerof the dialog box,

- _* Picture Name and Destination. Onthis screen (Figure 7-1, middle right), Windows
“», asks you to type the nameof the group of pictures to be imported. If you name

“this group Robin’s Party, for example, Windowswill put the downloaded photos
© into a My Pictures—Robin’s Party folder. (It will, that is, unless you intervene by
oS clicking the Browse button to choose a different folder.)
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after copying them.”If yu turn onthis checkbox, then you'll find your memory card ireshly erased after the
photo transfer, ready for more picture taking. 

+ Other Options. When the transfer process is over, the next screen (Figure 7-1,
lowerleft) offers you direct links to publishing the photos to a Website, ordering
prints by mail via the Web, or Nothing—whichis almost always what you wantto
do here.

+ Completing the Scanner and Camera Wizard.Thefinal screen (Figure 7-1,lower °
right) completes the process by offering youalink that opensthe folder currently
containing the pictures (on your hard drive). Click either the link or the Finish
button, which does the same thing.

Fun with Downloaded Pictures

Once you've transferred pictures to your hard drive, you can enjoy a longlist of
photo-manipulation features, new in Windows XP. These features put to shame the
national photo-managementsystem:shoving drugstore prints into a shoebox, which
then goesinto a closet.

Choose ar event below. then select the action te take when that
event occurs, 
 
 
 

«= Behingiger

 
 

 
  
 
 
 

  
 
 

- CO) Star ths programe BB
oy Prampl fot which proguam ta tien.

©) Take no action os “
DSaveall pictues to thig falas

 
 
 

[2] Createa subfolder usitg todai’s date ©: "
2 BY Gelet iokurds fom carmen: aft iy saving lem=0-0 
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Suppose you've opened a folder of freshly downloaded pictures. (As noted above,
they’re usually in a folder in your My Pictures folder, which itself is in your My Docu-
ments folder. Unless you've deliberately removed My Pictures from your Start menu,
just choose its name from the Start menuto get going. Or you can puta shortcut icon
for My Pictures right on your desktop.)

 
.. Here are some of the ways you can manage your picturesafter their safe arrival on
- your PC.

-. Download more photes
“When a camera or scanneris turned on and connected to the PC,thefirst link in the

~ task paneofyour MyPicturesfolderis, “Get pictures from camera or scanner.” Click
it to launch the Camera and Scanner Wizard all overagain.

 

Look them over
‘Windows XP comes with two folder window viewsespecially designed for digital
photos: Thumbnail and Filmstrip. You can read about them on page 78; for now,it’s

“enough to note that Filmstrip view (Figure 7-2)is ideal for reviewingabatch offreshly
transferred picturesat the size that’s big enoughfor you to recognize them.

 

 

Remember to press the F11 key to maximize the window and hidea lotofthe ancillary
oolbar junk that eats into your photo-displaying space. (Press F11 again to restore

thewindowsize when you're done.) Also rememberto rotate the photos that were 
 
 
 

 
 
 

 

 
 
 

~ Figure 7-2:
infilmstrip view,
theenlarged image
fowsthe currently

selectedphoto. You
anselect a different

‘one for enlargement by
dicking another image

 File Edit View’; Favorites: Tools. Helpon

 
 
 
 
 

 
 
 
 

 
 
 

  

Oneninfant

 

. pen in Paintshor
on(bottom row) or by Open in Photoshon

dicking the Previous and ee
Nextbuttons beneath Prine 
  

 

Rotate Chickwise
Rotete Counter Cackwise

 
 

  

 Don’tmiss the special
taskslisted in the task
ane atthe left side-or
2 options in the menu

File and Fulder Tasker
  

 Oper with
Sere te  

 
 

 
 

 
thatappear when you Deletefit-click the central oSpee

enlarged inimage.

  jpg Captiva Islnd 020.Jng Captive Island 024. Jog
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taken with the camera turned sideways, especially if you plan to use the slide show,
Web page, or email features described in the following paragraphs. 
 

Tip: Whenrotating a photo in Filmstrip view (Figure 7-2), Windows sometines announces. “Because of the
dimensionsofthis picture, rotating it might permanently reduceits quality. Do you want to proceed?”

 This scary message pops up only when you're trying to rotate a photo whese dimensions (measured in
pixels) aren't an even multiple of sixteen. Windowsis letting you know that, thanks to a quirk in the science
of JPEG compression, if must recompress the graphic in order to rotate it. Microsoft says that the “quality
loss"is imperceptible to the human eys, and you'll probably agree, Butif you're worried aboutit, make a
copy of the original photofile before you rotateit. 

Start a slide show

When youclick “View asa slide show”in the task pane, your screen goes dark, thunder
rumbles somewhere, and your entire monitor fills with a gorgeous,self-advancing
slide show of the pictures in the folder. If you then move the mouse, a tiny palette
appears in the upper-right corner with buttons of control buttons that correspond
to Play, Pause, Previous, Next, and Stop.

The beauty of a slide showlike this is that everyone at your presentation (or,if this
is your home computer, in your family) can see it at once. It beats the pants off the
ritual of passing out individual 4 x 6 drugstore prints to each person.

To stop the slide show, press the Esc key on your keyboard (or click the X button in
the floating palette that appears when you move your mouse).

Note:Why do ohoto-related tasks appear on the task pane onlyin the My Pictures foider? Because Microscft
has applied the Pictures or Photo Album folder template to it, You can make these tasks appearin any other
folder, however, just by applying the same folder template; see page 79.

Order prints online
If you click this link in the task pane, Windows XP presents a wizard that helps you
select photos in your folder for uploading to an online photo processor, like Kodak, —
Shutterfly, or Fuji. You can specify how many copies you want of each print, and at
whatsizes (Figure 7-3). Once you've plugged in your credit card number, the prints
arrive by mail in about a week.

Make a printout
This task-panelink, too, opens a wizard.Thistime,it guides you througha selection of
photos in yourfolderto print,a selection of printers to use, and the layout of photos
on each 8% x 11 sheet (four 3 x 5 inch prints, 9 wallet-sized prints, and so on). Note
that many of these layouts chop off parts of your pictures to make them fit the page;
the layout previews will reveal exactly which parts of the image you'll lose,
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   - Install new wallpaper
“The “Set as desktop background”link (which appears whenever you've highlighted

” a picture) plasters the currently selected photo across the entire backgroundofyour
~ screen, turning your PC into the world’s most expensive picture frame.(For instruc-
tions on changing or removing this background,use the Display program described
“on page 261.)

 

  
   
 

 
 

 

 
 “2 Figure 7-3:

Ls. The price forprints vie
: b. Web is usually 50 cents
. for 4x 6 prints, and up
“fo $20 for a 20 x 30 inch

:. poster. Be especially
>. careful when you see

the red minus symbat
“1 shown here. it lets you
“1 knew that the reso-tu-
' tion ofthat photo is too
.. fow to make a good

*. qualityprint at thatsize.
A640 x 480-pixel shot,

~ [8 for example,will look
“grainy when printed at 5
“407 inches.

 
 

 
 

Ofete: Customize Your Onder - Step 1 of 5
Choose print sizes and quantities.
 
 

 
 
 

 
   ‘Brints: (PrintsbestUp’ta 20.4 30")
 
   

  
  
  
  

 
 

 
  
 _ Prints:Printsbestupto 4xoy Price:feQuantity:

044g. fT
  

 
Low-resolution warning 
 
 
 

 

 
 

:Post the photos on the Web
Inthe old days, creating and posting Web pages wasa task fit only for geeks. In Win-

dows XP, however, anybody can create a gallery of photos that hangs on the Web for
everyonein the worldto see.

Startby clicking “Publish this file ({folder] if no file is selected) to the Web”in the
taskpaneattheleft side of yourpictures folder window.Yes,it’s the Web Publishing
Wizard, whose screens waik you through this process:

 

 
 
 

 
 
 

 

 

 Choosing the photos (from the assortmentin the currentfolder) that you want
0put online. 

 
 

 

 ‘hoosing a Web-hosting companythatwill provide the disk space for your pictures
onthe Internet. Note that this means paying money—unless you choose MSN
Groups from the selection on the third wizard screen.
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Althoughit’s free to let Microsoft host your Web page in this way, there are two:
downsides. First, it limits you to 3 MB of storage—andthat’s not very manypictures”
(maybe a dozen). Second, using MSN requires that you have a Microsoft Passport,
See page 364for instructions and privacy considerations.

* Choosing an MSN Group (Web page) for displaying your new photos. Thefirst
time you dothis, you'll wantto select “Create anew MSN Groupto share yourfiles.”
Microsoft will nameyourfirst Web page for you,tell you the URL (Web address}
and offer to add the URL to yourlist of Favorites. When you create subsequent
pages, you'll be asked to type a namefor each, enter your email address, and type:
a description. Whether you're creating new or additional Web pages, the wizard
then asks you to indicate whether or not you wantthe Internetat large to beable."
to find this page.

 
 

 
+ The next wizard screen provides the URL (Web address) for your finished Web.

pagegallery: www.msnusers.com/[whatever nameyou provided for your Web page}.
You can distribute this address to friends, family, or whomever you'd like to invite
to view your masterpieces online.

 

: Another wizardscreentells you exactly where your Web-page document and graph-
ics files have been stored online. Unless you're some kind of Web-savvy HTML
guru, you probably won'tcare.

  

  

 Figure 7-4:
Do yng want in adjust pichuse sizes before publishing? : Top: The Web Publish-

ing Wizard offers
to scale down your

- graphics (the Web
Reta versions, not the origi-

nals) to reasonable
dimensions.

 

Bottom: You're a

publishedphoteg-
pee ptcooneal meme | her! You'll findfena, New — 4 ‘ 1 rapi er

seen met ” your photos at the
lower-right side of the

| @ asd.te“Koramusiting1Viste"—& RecommendthisCommunitytooFriend oe Web page. Click one
to open up that photo

Welcome to the family of MEN Communities. / atfull size—complete
You can view Sncunents ur Pictuies in this compnumity by clicking a fink on the jet with Previous and

P . Next buttons that letYou can alse use Cormmunitios ip share meagaggs, appointients,of lista wih your fends, .
Managers can expand the Commonity by adding new pages ee your audience conduct
Adda Page . : a full-sized photo slide

show on the Web.

Welegine‘Watcame to Capthrs iland, Whether you aie ¢ masager, membds, of visite bare wee hope you enjoy this MOMcoremurilty.
MBN Web Toounuties 03.02

 
gleeanseneseperanesesiestaeatEETUTETHAEMRTTIAN  
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> Most digital cameras create encrmousphotofiles, containing enough resolution
“for high-quality prints. Unfortunately, those files are much too large for use as
“. Web-page graphics, which feature far lower resolution than printouts do. As a
-~gemedy, the wizard screen shown in Figure 7-4 offers to scale the photos down
--to reasonable dimensions, so that you won't tie up the modemsofyour potential
. audienceall day.

 
Atlast, Windows uploads your reduced-size photosto the Internet, which can take

“sometime. Thefinal wizard screen offers you the chanceto go online, opening your
- browser automatically to the new Web page.

 

 
- Emailphotos
Photo files destined for printing are much too massive for emailing. A single digital

oto can occupy 2 MBof disk space or more, which would take until Thanksgiv-
ng to send by email. Even then, a photofile might never reach yourrecipient. Ifit
werflows her email account's storage limit (typically 5 or 10 MB), it will just bounce
ack to you. Then you'll be forced to sit and wait while it downloads right back to

: you-—a fitting punishment for uploading suchabigfile to begin with!

 

 
"Thesolutionis the “E-mail thisfile”link in the task pane ofyour pictures folder, which
-appears wheneveryou've highlightedatleast one picture. Clicking this link produces
thedialog box shown in Figure 7-5, whichoffers to smoothly reduce the dimensions
f your pictures in the process of emailing them.

 

 
rice you click OK, Windowsautomatically launches your email program and opens

New; outgoing email message, with the photo files (reduced in size, if that’s what
specified) already attached. All you need to dois indicate the address, a subject

line; and some comments (in the body of the message),if you like.
 

tthis point, you can drag the reduced-size picure attachments directly cut of the email and back to
r desktop, or to a waiting folder, without ever addressing or sending the message. Doing so capitalizes

‘photo-shrinking powerof the “E-mail this file” feature—without actually emailing anything.
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Create a photo screen saver
There’s no “Create photo screen saver” link in the task pane of a photo folder, but
WindowsXP canstill turn yourfavorite pictures into an automatic slide show when-
ever your computerisn’t in use. Just right-click the desktop, choose Properties from
the shortcut menu,click the Screen Saver tab in the resulting dialog box, and then
choose My Pictures Slideshow from the “Screen saver” drop-down list.

 
 

Tip: The screen saver is composed of photos in your MyPictures foider. If you'd like to choose a different
folder as fodder for the slide show, click the Settings button, and then click the Browse button. You'll be
offered the chance to choose any folder on your hard drive. 

From now on, whenever your PC has gone untouchedfor five minutes (or whatever
interval you specify here), your pictures will fill the screen, complete with special.
transition effects between images, if you so choose. 
 

Tip: |f you're the impatient sort, simply press the right and left arrow keys on your keyboard to summon
the next or previous photo while the screen saver Is playing. 

 
 Figure 7-5:

Top: ifyoujust click OK, the selected
photos will get emailed at 640 x 480
pixel resolution—just rightfor satis-
factory viewing (andfairly speedy
transferring) by email.

 
 

Bottom: Clicking the “Show more
options”link offers you the opportu-
nity to specify which reduced size you
want.

ohCancel. b

View them digger
Ifyou double-click a picture or scan a file whosefile type you haven't assigned to open
in a particular graphics program,it opens up in a program called Windows Picture
and Fax Viewer. WPFY, as Windowsveterans don’tcall it, is a strange, phantomlittle
program.It doesn’t show up in your Start menu and you can’tfindit by searchingfor
it. You can only openit by double-clicking a graphic or by right-clicking a picture’s
icon and choosing Preview from the shortcut menu.
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 heresult is a simple preview window (Figure 7-6). At the bottom edge,you'll find
sttons that do exactly the kindsof things you've been reading about: Show theprevi-

OF next image, start a slideshow,rotate the graphic, printit, email it, and so on.

igure 7-6:
“Fg fearn what each button does, point to it
Withoutclicking, The Zoom in andZoom Out
“buttons magnify or reduce the image on the

-screen; and the Delete button deletes the file
from your hard drive (or, rather, flings it into
theRecycle Bin).

 
 
 

Delete (Delete)

Captiva Island Captiva Isfand2  
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Scanning
As far as Windows XPis concerned,a scanneris just another kind ofdigital camera. -
When an XP-compatible scanneris turned on and connected to the PC,for example, :
the Camera and Scanner Wizard starts up automatically. (If it doesn’t, open your My ©
Pictures folder, You'll see that thefirst link in the task pane is, “Get pictures from
camera or scanner.” Clicking launches—-you guessed it—the Scanner and Camera
Wizard.)

The options you see during the march of the wizard screens are very similar to the |
ones described in the previous pages. The chief difference is the Choose Scanning.
Preferences screen, where youre supposedto indicate what kind of scan you wantto.
make (color, grayscale, or black and white) and what portion of the page you want
scanned (by dragging thelittle square handles on the preview ofthe page). ,

To view and manipulate your scanned images, use the commandsin the My Pictures
task pane. Youd benuts to order prints of something you've just scanned, however.
Instead, you'll probably wantto use the software provided by the manufacturerto:
open and edit your imagefiles. Or, if you haven't installed such a program, you can
just double-click the scanned document's icon to openit in the WindowsPicture and
Fax Viewer (page 220). :

Windows Media Player
You can use Windows Media Player—one of the most useful freebie features ofWin-

 
 

dows XP—to play sounds,play digital movies, or tune in to Internetradio stations. ° -
It’s the Grand Central Station for digital music and movies, as well as the junction
for your hard drive, CD player, CD burner, MP3player, and the Internet(from which
you can download new musicfiles and movieclips). :  
In its insatiable quest to dominate the world of digital music and video, Microsoft
keeps updating Windows Media Player, usually redesigning it beyond recognition
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* with each update. For example, Windows XP originally came with version 8. Ver-
~~ gion 10, described in these pages,is infinitely better-looking and moreclearly laid

- out, If you don’t have Windows Media Player 10, you can downloadit for free from
- Microsoft's Website.

| The Lay of the Land
- The top edge, as you may have noticed, now offers six primary tabs, which cover the
. essential functions of Media Player. They're described in more detail in the following
~ pages, but here’s a quick overview:  

_\ « Now Playing. Click this tab while music or video is playing from any source. This
is where you can see a list of songs on the CD, a graphic equalizer, and a wild,

psychedelic screen saver that pulses in time to the music.
 

_ * Library. This screenis like a Windows Explorer display—-a folder tree on theleft
side, and the contentsofa selected folderlisted on the right—thatlists every piece
of music or video your copy of Media Player “knows about” on your hard drive.
This is also where you can sort your songs into subsetscalled playlists.

. * Rip. Use this screen to copy songs from one of your music CDs onto your hard
drive, as describedlater in this chapter.

. * Burn. After transferring some songs to your hard drive—from theInternetor your
_ own music CD collection—you can then burn your own CDs. This screen is the

“: loading dock.

: Sync. Here’s where you line up music or video that you'd like transferred to a
“portable music or video player, if you have one that Media Player understands. 
 
 
 
 

 

 
 

 
 

 

* Guide. This page is a rabbit hole into Alice in Marketingland. You wind up ona
-<' Microsoft Web site that tells (and sells} you everything about Media Player and: - the latest downloadable offerings from Microsoft andits partners.
Playing Music CDs
Forits first trick, Media Player can simulate a $25 CD player, capable of playing your
music CDs while youre working at your computer. Tofire it up, just insert an audio
cD into your computer’s CD or DVD drive.
Unless you've fiddled with the settings, Media Player opens automatically and the
cD beginsto play. The screen even fills with a shimmering,laser-light show (called
avisualization) that pulses along with the music. Ta-da!

(IfWindows instead asks what you want to do with the CD, see Figure 7-7.)

Fip:if ail the fancy dancing-to-the-music graphics are slowing down your machine as you try to workin
herprograms, you can always tum them off (choose ViewVisualizations--»No Visualizations). If you

‘can'tfind the menu bar, see Figure 7-7, 
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And if you have more than one CD drive with a discin it (or, say, one audio CD and
one DVD), you can tell Media Player which disc you wantto play by choosing from
the little down-arrow menu next to the Now Playing tab,

 
 
  

   
 

 
  

  
 

  

 Figure 7-7:
Top: Windows may ask
what you wantif to do
with a music CD. ifyou
accept the Play Audio CD
using Windows Media
Player option by clicking
OK or pressing Enter,
Windows Media Player
opens autamatically and
begins io play the songs
on your CD.

  
  k Select a content bine, then choose an action for Windows to

 

 
 

 
 

# Select an action to perfoen:

apaudia CD aoe
singWindows Media Player

 
 

 

 
 

 

 

 
 
 
  

  
 

 

 
 

§ Take ne action
 

Bottom: This ifustration
identifies the functions of
some ofthe less obvious
controls.

C2 Promat me each aime lechoose 4m action, |

 
  

  
   
  
  
  
  
  
   
 

  

 
 

For example, whenever
the Media Player window

Visuaizer Quick Access Full Screen Hide/show—Hidden sn ¢ maximizedhe vou.
menu menu Clab+Enter) mode (Alt+Enter) playlist.==main menu menu bar is Aidaen. fou

can summon it—verticalfy
instead ofhorizontally—by

, clicking the triangle
> identifiedhere, Or your

  

 

can refurn it to its rightfut
place bypressing Cirl+M.

Or, ne matter what your
windowsituation, you
can right-click the tabs or
thetitle bar to produce
a pop-up version of the
menu bar.

ifyou don’t see the list of
tracks at the right side of
the window, click the Hide’
Show Playlist button.

 

 
 
  

 
 
 

Play/Pause, Stop, Next Track/ Shuffle mode
Previous Track, Mute, Volurne

Switch to Skin mode
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. Funwith Media Player
When youreveryday workleaves you uninspired, here are a few of the experiments
you can conduct on the Media Playerscreen design:

Switch visualizations. ‘Io try a different visualization,click the Next Visualization
orthe Previous Visualization arrow {the tiny arrow buttons just below the Now
Playing tab}, or press Tab+Enter and thenclick theVideoSettings button, or choose
View—Visualizations. And if you tire of the displays built into Windows, then
just download moreof them from the Internet by choosing Tools>Download—
Visualizations.

 
 

Tip:Oneof the most interesting choices is Album Art, which displays a picture of the album cover for
ichever songis now playing, 

  
  

 

 

 

  

‘Shrink the window to show someskin.If the Media Player window is taking up
00 much screen space, making it harder for you to work on that crucial business
plan asyoulisten to *NSync, press Ctrl+2 to shrink the window, or choose View3
‘Skin Mode (see Figure 7-8). Press Ctrl+f to return the Media Player window toits |<”:
full-sized glory. (Of course, you can also just minimize MediaPlayer, as you would
any window.)

 
   
 Expand the window. On the other hand,ifyour PC is briefly servingas a glorified

stereo system at a cocktail party, choose View—Full Screen (or press Alt+Enter).

Select 4 content pe, then choose ar actiontar Windows to
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The screen-saver effect now fills the entire screen, hiding all text, buttons, and
controls. If you have an available coffee table and a laptop to put it on, you've got-
yourself a great atmospheric effect. (When the party’s over, just click the mouse, .-:
or press Alt+Enter again, to make the standard controls reappear.)

* Changethe skin. In hopesof riding the world’s craze for MP3files, Microsoft has
helpeditself to one ofWinAmp’s mostinteresting features: skins. (Definitions: (An
MP3file [MPEG Audio Layer-3] is a compact, downloadable, CD-quality sound —
file format. WinAmpis a popular MP3-playing program. Anda skin is a design

  Figure 7-8:
At full size, the Media Player window occupies a
large chunk of your screen (Figure 7-7). in Skin Mode
(Ghown here), if takes up less space on your screen
and can use any of dozens of radical new design
schemes. it can show both visualizations (when you're
playing music) and video (when you're playing—well,
you know).

To return to the full-size window andits full-size
complementof controls, press Ctrl+i, or hunt through
the various buttons on your skin until you find the
Return to Full Made button.

 

 Figure 7-9:
Not aff skins are, shall we
say, masterpieces ofintui-
tive design;in fact, it may
take you several minutes
just to find the Stop button.
When youfind a skin you
like, click Apply Skin (above

eae : ; ee | the list). ifyou don’t hike any
 Copporate __ofthe designs orjust want

: : to keep looking, dick More
Skins. Windows sends you
fo the Internetfor a visit to

Microsoft's grisly-sounding
Skin Gallery. Ifnothing there
strikes your fancy, either
search the Web or check
back later, as Microsoft
expands the collection

"periodically.
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scheme that completely changes the look of Windows MediaPlayer, as shown in
see Figure 7-9.)

To choose a new skin, choose View—Skin Chooser. Thenclick each of the available

skins, listed down theleft side, to see a preview of its appearance. When you click
the Apply Skin button (at the top-left corner of the window),your player takes on
the look of the skin you chose and shrinks down into the compact Skin mode,as
described in the previoustip.

+ Fool around with the playback sequence. You can make the songs on the CD play
back in a random order,just as though you'd pushed the Shuffle button on a CD
player. To do this, just click the Shuffle button (identified in Figure 7-7) or press
CtrltH—theshortcutfor the Play—>Shuffle command.Andifyou love a particular
CD so muchthat yourd like to hear it over and over again (instead of stoppingat
the end), press Ctrl+T—the shortcut for Play>Repeat.

 
Tip: These tricks work for whatever playlist you've currently selected—not just an audio CD. (Playlists are
described later in this chapter}   

* Foo] around with the sound. Don’t miss the graphic equalizer,a little row ofsliders
that lets you adjust the bass, treble, and other frequencies to suit your particular
speakers and yourparticular ears. In version 10, Microsoft madeit pretty hard
to get to—View->Enhancements—>Graphic Equalizer~-but it’s there. (The same
submenuoffers something called SRS WOW, which simulates a 3-D sound experi-
ence through nothing more than stereo speakers or headphones.)

* Read the “CD booklet.” If you click the Rip tab and then click Find Album Info,
MediaPlayer goes onlineto retrieve a useful display of information from the CD
yourelistening to. You're shown songtitles, track links, singer names, and miscel-
laneous album information that even includes a little review and, needless to say,
an opportunity to buy another copy of the CD online.

 

Copying CDs to Your Hard Drive
You can copy an album,or selected tracks, to your hard drive in the form of stand-
alone musicfiles that play when double-clicked (a process called ripping, much to
the consternation of sleepless record executives who think thatit’s short for ripping
off). Having CD songs on your harddrive is handy because:

* You can listen to your songs without having to hunt for the CDs they came
from.

* You canlisten to music even ifyou're using the CD-ROMdrivefor somethingelse
(like a CD-based game).

* You can build your own playlists (sets of favorite songs) consisting of cuts from
different albums.

* You can compressthefile in the process, so that each song takes up muchless disk
Space,
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+ You can transfer the songs to a portable music player or burn them onto a home-
taade CD,

If you're sold on the idea, begin with a quick trip to the Tools-»Options menu.Click
the Rip Music tab, and then inspect your settings. For example, if you intervene by
clicking the Change button nearthe top, Windowswill copy your songfiles into the
My Documents>My Music folder.

Note, too, that Microsoft has designed Windows Media Player to generatefiles in the
company’s own proprietary format, something called Windows Media Audio (WMA)
format (.wma). But many people prefer, and even require, MP3 files. Por example,
most recent CD players and portable music players (including the iPod) can play back
MP3 files—but won’t know what to do with WMA files.

 
 

If youd prefer the more universally compatible MP3 files, use the Format pop-up
menu to choose “mp3”(see Figure 7-10}. And rejoice: Until Media Player 10 came
along, you hadto pay $10 extra for the ability to create MP3files.

  
Tip: If you have a stack of CDsto rip, don't miss the two checkboxes here: "Rip CD when inserted” and
“Eject CD whenripping is complete.” Together, they turn your PC into an autometed rippingmachine,ieav-
ing nothing for you to do but feed it COs and watch TV. (Of course, now Media Player won't automatically
play CDs when you insert them.)

Figare 7-90:
Music files occupy a fot ofspace on the hard
drive. By adjusting this slider, you can specify
how much Windows compresses the song
files, with the understanding that you sacrifice
sound quality as you makethefile smatfer.
Experiment with the other settings to accom-
modate your ears and speakers.

(ff you've selected the Windows Media format,
iry the Variable option. It maximizes audio
quality and minimizes file size by continu-
ously adjusting the data rate along the song's
length, as needed.)
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'. Finally, the sliderin this dialog boxlets you control the tradeoff,in the resulting sound
files, between audio quality andfile size. At 128 kbps, for example, a three-minute

os MP3file might consume about 2.8 megabytes. At 192 kbps, the samefile will sound
- much better, but it will eat up about 4.2 MB, Andata full 320 kbps,thefile will be

’ roughly 7 MB.

- These are importantconsiderationsif you're ripping for a portable MP3player,like
= the iPod. Por instance:if your music player contains a 20 GB hard drive,it can hold
. 142 hours of music you've ripped at 320 kbps, or 357 hours at 128 kbps.

~ For MP3 files, most people find the 192 Kbpssetting (on the “Audio quality”slider}
to produce great-sounding,relatively compactfiles. For WMA,128 Kbps might be a
- good starting point. Needless to say, let your ears (and the capacity of your portable
- music player) be your guide.

. ‘Click OK, then begin:

_1. Insert the music CD,Click the Rip tab at the top of the Media Player window.

» Thelist ofsongs on the CD appears. See the box on the facing page for information
-on ensuring that the album nameand track namesare correct.

2.Turnoff the checkbox of any track you don’t wantto copy.

Tae 
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You've waited all your life for this: At last, you have the power to eliminate any
annoying songs and keep only the good ones.

Andwhile you're playing record-company executive, take a moment to drag the
names of the songs up or down thelist to rearrange them.

3. Click Rip Music.

You'll find this button in the narrow strip above the list of songs.

Media Player maytake this opportunity to present a Rip Options dialog box, whose
purposeis to beg you, onelast time, to choose one of Microsoft's WMA formats
instead of MP3.Click “Keep my current format settings” and click OK.

 
Windowsbeginsto copy the songs onto your hard drive. The Copy Music button
changes to Stop Copy, which youcan click to interrupt the process. 

Organizing Your Music Library
Every CD transferred to your hard drive winds up with an entry in your Library
menu, identified in Figure 7-7. Makethat several entries, actually, as this Explorer-
like tree view lets you see your collection sorted by composer, album,year released,
or whatever. Whenever you wantto play back some music, just double-click its name
in this list—there’s no need to hunt around in your shoeboxesfor the original CD
the songs came from.

 

Butthat’s just the beginning of Media Player’s organizational tools; see Figure 7-11. 
Figure 7-17;
Navigate your
library (left and
middle panels).
Drag each song or
CD name into the

New Playlist list
(right panel). 
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ransferring CD songs to your hard drive isn’t the only way to log yourfiles in the
diaPlayer database. You can also add soundandvideofiles to this masterlist us-
any.of these methods:

 

se the Tools—>Search for Media Files command (or press F3).

Dragsound or video files directly from your desktop or folder windows into the
Media Player window.
Choose File+Add to Library (orclick the Add to Library button at the bottom of

& Library screen). From the submenu, choose Add Currently Playing Item, Add
Ider, Add URL (forfiles on the Web), or whatever.

 

 

‘he Internetis crawling with Websites thatsell downloadable musicfiles that you
make part of your musiclibrary. At the top-right corner of the Media Player

ndow, a drop-down menulists them (Napster, Musicmatch, MSN Music, Wal-
MartMusic Downloads, and so on). When you choose a music store’s name, the

- ia Player window ducks into a phone booth and becomes a Web browser,filled
with thecorresponding company’s wares. Anythingyou buygets gulped right into

Library, ready for burning to a CD orsyncingwith an audio player.

 

 

u've createdawell-stocked fridge of music, you can call up a particular song
typing.into the Search box (at the top of the Librarylist), by navigating the folder

eleft side of the Media Librarylist), or by using the playlist list (in the My

sts category of the Librarylist).

 

  

 

above, each CD that you transfer to your hard drive becomesa playlist in
dows Media Player: a group of songs, listed in the foldertree at the left side, that

playback with a single click. Media Player automatically turns your CDsinto
butyou can also create your own, mixing and matching songs from differ-

albums for different purposes (which you might name Downer Tunes, Makeout

 

  

ea]new playlist, make sure you've selected the Library tab. Then click New
(upper--right of the Media Player wmdow). From the drop-down list, choose
~Playlist.

laylistpanel, at the rightside of yourscreen,is empty.It says, “Drag items here
da listof iitems for yourplaylist.” Well, hey—it’s worth a try. See Figure 7-11.

yo vecreated a playlist, click that New Playlist button/menuthing aboveit once
his time, choose Save Playlist As from the drop-down menu,type a namefor

t, and thrill to the appearanceofa new icon in the MyPlaylists “category”
Deylist left panel).

out wantto delete a song,a playlist, or almost anythingelse, the key is to
You'll find the Delete commandin the shortcut menu. 
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Burning Your Own CDs
The beauty of a CD burneris thatit finally frees you from thestifling restrictions
put on your musical tastes by the record companies. You can create your own “best
of” CDsthat play in any CD player—and that contain only your favorite songs in
yourfavorite order.

See Figure 7-12 for instructions.

 
 Figure 7-12;

Top: The easiest way fo create a
CD in Media Playeris to assemble
the songs you want in a custom
playlist. as described in the previ-
ous section. Choose the playlists
name from the Burn List drop-
down menu.

 
 if you haven't already built a

playlist, you can assemble a one-
timelist by clicking the Edit Playlist
fink.

Bottom: The resulting window lets
you hand-pick songs frem your
library. Use the “View library by”
drop-downlist to choose how
you'd like to see your library listed.
by genre, album, TV show, and
so on.

Once you've assembled the audio
CD-to-be, insert a blank CD into
your burner, and dick the Start
Burn linkjust above the list of
songs. The transfer process takes
quite a bit oftime and quite a bit
of hard drive space, so budget
appropriately for both. When the
process is complete, your PC spits
out the CD automatically.

 
  

   
 

 
: The World tonFair aad+ House On Fire 525 4

Total Time:

Copying Music or Video to a Portable Player
If you have a pocket gizmo that’s capable of playing music (like a Diamond Rio or a
Pocket PC) or even videos(like a Portable Media Center); the process for loading your
favorite material ontoit is very similar to burning your own CD.Theonly difference

 

WINDOWS XP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 246

 



HP Inc. - Exhibit 1007 - Page 247

 
 
 

 
 
 
 

‘inthe procedure’is that you do your work on the Synctab instead of the Burntab. But
youchoose a playlist to transfer (or hand-pick material) in exactly the same way.

“The beauty ofa Portable Media Center gadget, in fact, is that Media Player can keepit
ynced. As yourlibrary grows, shrinks, or gets edited, you can sleep soundly, knowing
at your portable gadget’s contents will be updated automatically the next time you

ookiitup to your PC’s USB port. 
ip:: MediaPlayer can play videos with the extensions wry, wx, .avi, Mpeg, .mpg, .mpe, .m1v, .mp2,

_mpa,and iM.
ASyou may have noticed,this list doesn’t recognize two of the most popular video-file formats: QuickTime

dRealVideo.To play thesefiles, you'll need the free QuickTimePlayer (availabie from waa apple.com/
vicktimey or RealPlayer (from wwwreal com). 
 

  
 

 
 

 
 

‘Internet Radio
he20008" twist on listening to the radio as you workis listening without a radio,

wadays, the computeritself is used as a radio,one that can tune in to hundredsof
diostations all over the world, each broughtto you by the Internet,

 

 
infortunately, Microsoft opted to axe the radio feature from MediaPlayer 10; it can
o longertunein Internet stations—atleast, notfor free. Ifyou wantto listen to radio

m:-Wwithin Media Player, you're expected to sign up for a paid subscription from
neofthe online music stores describedearlier, (Of course, you can find hundreds

eeradio stations on the Web.}

 

 

 
 
 
 

 

ingDVD decoding software too. f not, or ifyou'veinstalled your own DVD drive, you'll have to spring
ew bilcks fot DVD decoding software like DVD XPack (wwmintervideo.com, $15), NVidia DVD Decoder

wy, vidio com, $20), or PowerDVD (mwgecyberlink.com, $15).
 

bichingimovies on yourscreen couldn't be simpler: Just insert the DVD, Windows
aut matically detects thatit’s a video DVD—asopposedto,say, one that’s just

‘ithfiles. Then, dependingonthesettings you madein the dialog box shownin
-7; it either opens MediaPlayer automatically, opens your add-on DVD-play-

ware,0or gives you the choice.(Ifnot, no problem: Open MediaPlayer yourself
enchoose Play->DVD, VCD or CD Audio—[your DVD drive’s name}.)

+

 

diaPlayer starts out playing your movieinarelatively small window. But you didn’t
isBeand pay this much,just to watch movies on a mereslice ofyourscreen.
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Yourfirst act, therefore, should be to enlarge the pictureto fill the screen. Pressing
Alt+Enteris the easiest way, but you can also choose View->Full Screen orclick the
Full Screen button (see Figure 7-13).
  

Figure 7-13:
Once the DVD is playing,
you controf the playback
using the standard Media
Player controls (at the
bottom-left edge ofthe
window). To switch to a
different “chapter,” use the
list af right (click the litle
Show Playlist button if you
don't seeif}.

To change language or
parental-control options,
choose Tools—Options and
click the DVD tab.

When you're playing the
movie full screen, the
playback controls reappear

= a — when you move the mouse
Playback Hide/show Chapter fist abit
controls chapterlist (double-click)

  

 
DVD menu

  

After you enlarge the screen, playback controls appear for a few secondsat the lower-
left corner of the screen, permitting you to speed backward or forward through the
movie, and then fade away so as not to obscure Arnold Schwarzenegger's face. To
pause the movie, jump aroundin it, or advance one frameat a time, just twitch the
mouse to make the controls (and the playlist of DVD chapters) reappear.

 
 

Alternatively, you can right-click anywhere on the “movie screen”itself to reveal a
menu of disc-navigation features.
 

Tip: For real fun, turn on English subtitles but switch the soundtrack to a foreign language. No matter how
trashy the movie you're watching, you'll gain much more respect from your friends and family when you tell
them that you're watching a foreign film.  

Ditching the remote control
Whenthe remote control is hidden, you can alwaysreturn it to the screen just by
moving your mouse. But the true DVD master would never bother with sucha sissy
technique. The secret keystrokes of Media Playerareall you really need to know:

 

Function Keystroke
play Ctrl+-P
stop Cerl+S
fast forward Ctri+Shift+F

: Bs - s - a Ss WINDOWS XP PRO: THE MISSING MANUAL
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rewind Cil+-Shifi+B
jouger FIO

quieter F9
mute FB

next/previous “chapter” Ctr+F, Ctrl+B
full-screen mode Ait+Enter
eject Ctr+E 

Tip: Watching a movie while sitting in front of your PC is not exactly the great American movie-watching
“. dream. To enhance your viewing experience, you can always connact the video-outputjacks of your DVD-
© equipped PC (most models} to your TY.

+ Just be sure to connect the cables from the PC's video-cutput jacks directly to the TV. If you connect them to
your VCR instead,you'll get a horrible, murky, color-shifting picture—the result of the built-in copy-protection

© qincuitry of most VCRs. 

Making WAVs withSound Recorder
“. Windows XP comes with a generous assortment of soundfiles that you can use as

etror beeps, as described in Chapter 8. But noerror beepis as delightful as one that
‘you've made yourself—of your two-year-old saying, “Nope!” for example, or your
own voice saying, “Dang it!”

Figure 7-14:
Sound Recorder (top) lets
you capture the sounds
ofyour world—digitally.
Volume Control (bottom)
offers left-to-right stereo
balance controls and vol-

ume adjustments for every
sound-related component
of your PC.
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 Using Sound Recorder (Figure 7-14) requires a sound card, speakers, and a micro-

phone.Ifyour PC is appropriately equipped, you can use this little program to record
various snippets of yourlife, which can serve a numberof purposes, including error
beeps.

  “=MakingWAVS with
Beecer 

Recording a New Sound
Here’s how to doit:

1. Choose StartAll Programs—Accessories—>Entertainment—Sound Recorder.

The window shown at top in Figure 7-14 appears.

At this point, you may wantto take a detour by choosing File-+Properties. In
the resulting dialog box, click Convert Nowto specify the sound quality of the
recording you're about to make. The choices in the Name drop-down list—Ra-
dio Quality, CD Quality, and so on—indicate not only the sound quality, but
also how much disk space the file will consume. (Better quality takes up more
disk space.) Click OK twice after you've madeyourselections. 

tw . Click the Record button, make the sound, and thenclick Stop as soon as possible
thereafter. 
Ifyou see animated sound waves in the Sound Recorder window,great; that’s your
VU (soundlevel) meter. It tells you that the PC is hearing you.Ifyou don’t see these
yellow lines, however, then the soundisn’t getting through. Mostlikely, the prob-
lem is that your PC control panel ist’t set to record the appropriate sound source.
Choose EditAudio Properties, and then use the Default Device drop-down list
in the Sound Recordingsection to choose your microphone’s name.

If it’s impossible to capture a clean sound,free of dead space—because you're re-
cording babies or animals whorefuse to perform on cue, for example-—you're not
out of luck. You can always edit out the dead space. Use the scroll bar to position
the handle just before the dead space at the end of the sound, and then choose
EditDelete After Current Position.(To get rid of dead space before the goodpart,
position the handle and then choose Edit—Delete Before Current Position.) 
At this point,click the Play button to see what you've got, If it isn’t quite what you
had hoped,repeat this step; yourfirst take is automatically obliterated.

Tip: Don't miss the good times that await you in the Effects menu. You can increase or decrease your
recording speed, add an echo effect, or even play it backward—great for finding subliminal messages in
your own speech.

When you've got something worth keeping, go on:

3. Choose File—sSave As. Type a name for your sound file in the “File name” text
box, choose a folderfor it, and then click the Save button.

You've just created a .wayvfile, a standard Windows soundfile.
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What to Do with Sounds = MakingWAVS Tt
eeeaebaereS When you double-click a .wav file that you've saved to your desktop,thefile opensin

: Windows Media Player andplays back immediately. (Press Esc to interrupt playback.)
Sound files are also ideal for emailing to other Windowsusers, posting on Web sites,
transferring over the network, and so on. ManyaBart Simpson soundclip proliferates
~via the Internet in exactlythis way.

Finally, ifyou put a .wayfile into your my Computer—Local Disk (C:)>Windows
Media folder, it joins the other sound files that Windows uses for its various error

“beeps. You can thenusethe instructions on page 293 to replace Windows XP’s sound
~ effects with ones you've created.

~ Volume Control
>This program has perhaps the most understated nameofall time. As you can see
~ by Figure 7-14 at bottom,the program looks more like a 747 cockpit than a simple
“volume knob.

in any case, the controls here govern the volume and balance levels of the speakers,
microphones, and sound-card elements of your PC, Every PC’s sound card and

“other features are different, so not all of the controls may be operational on your
- tnachine...but you get the idea.

Here are a few things you might want to do with Volume Control:

Shut your PC up.Clicking “Muteall”at the lower-left corner of the window com-
pletely silences your PC—a handy feature, for example, when you don’t want an
‘errant beep or squawkto let everyone in church know youre using a laptop.

o ‘Adjust the stereo balance of your PC speakers. If one of the speakers is farther
"away from your head, you might wantto drag the Balanceslidersso thatthe distant

speakerplaysa little bit louder.

Fine-tune Musical Instrument Digital Interface (MIDI) playback. If your sound
= card can play back MIDIfiles (a compactfile fermat for instrumental music), use
_., the Synthesizer balance and volume controls to tweak its sound.

Adjust the bass andtreble, These knobs don’t appear on the Volume Controlscreen.
You must choose Options—Advanced Controls, and then click the Advanced but-
ton to see these sliders,

Tip: if you rarely use certain Volume Control features, or if some of them don't apply to your system, or if
your system has features (like a microphone) that don’t have corresponding controls, you can hide or show
ndividual panels, To do that, choose Options—>Properties. Then in the Properties dialog box, a scrollinglist

"of checkboxes lets you independently hide or show eachof the volume controls—Synthesizer, CD Audio,
Line In, Microphone, and so on.
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Windows Movie Maker 2

Movie Maker 1.0 was Microsoft’s first effort at video-editing software.It let camcorder
ownersedit the boring parts out of their footage, add crossfades, and save the result
as a digital file for emailing to friends or saving onto a disk.

Otherwise, though,it was the very definition of lame, offering only a single kind of
transition between clips, no special effects, no way to add credits andtitles, and no
way to send your masterpiece back out to the camcorder for playback on a TV.

Movie Maker2,released at the end of 2002, remedies every one of those problems and
more;it’s now onlyslightly lame. Unfortunately, version 2 didn’t come with the original
copy ofWindowsXP Pro.Ifyou don’t haveit, you can downloadit from Microsoft's
Website (www. microsoft.com/windowsxp/moviemaker), or use the Windows Update
feature described on page 255.

Equipment List
Editing is the easy part. The hard partis getting equipped to do so,since there's no-
where to plug a camcorder into a standard PC. To use Movie Maker, proceedin any.
of these three ways:

* Use analog equipment. In other words, use a standard camcorder or VCR, and
play your footage into your PC from standard VHS, 8 mm,or Hi-8 tapes.

A quick inspection ofthe back of your computer, however, should make clear that
it has no connector for a VCR. Therefore,you also need to buy a video capture card
or one of those inexpensive USB capture boxes designed to let you pour video into
your PC. The quality mightbe grainy, though, since Movie Maker achievesits goal
of creating emailable moviefiles by heavily compressing your video.

* Use digital equipment.Ifyou prefer better quality, use Movie Maker with a digi-
tal (DV) camcorder. A digital camcorder ($600 and up) uses special tapes called
MiniDV cassettes. (Sony Digital8 models are the exception, as they record onto
ordinary Hi-8 tapes—saving you money in the process.)

Note; Although the new, shockingly tiny Sony MicroMV camcorders are indeed digital, their signal is incom-
patible with Movie Maker. Sony says that it’s working with Microsoft on revising Movie Maker for MicroMV
compatibility. In the meantime, you can use the software that comes with the camcorder-MPEG Movie
Shaker-to grab the footage from the camera. You can then irnport the resulting files into Movie Maker. 

Next, you need a FireWire card (about $60). You insertthis kind of add-on circuit
board, sometimescalled an FEEE-1394 ori.link card, directly into your PC. On the
side of almost every digital camcorder modelis a special connector, a FireWire
port, that connects to the FireWire card with a special FireWire cable. This single
cable communicates both sound and video, in both directions, between the PC
and the carncorder.
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* Use existing pictures or movies. You can use Movie Makerto edit existing movie
© files you've downloaded from the Internet or copied from CD-ROMs,or even to
.. splice togetherstill photos that you've scanned or captured fromadigital camera
| for the purpose ofcreating a living photo album. 

: Note: If you're working with a digital camcorder, you need a /ot of hard drive space.Digital video foctage
“fakesup 3.6 MB persecond of video—enoughto fill up 10 GB in about 40 minutes. 

See Chapter 14 for tips on installing cards. And be sure to ask about Movie Maker
Windows XP compatibility before you buy any cards.

Getting Started with Movie Maker 2
After you've downloaded and installed Movie Maker, you open the program by
‘choosing Start—>All Programs—AccessoriesWindows Movie Maker. The Windows
Movie Maker screen appears, shown in Figure 7-15.Its left-side task pane indicates
thethree major steps you'll take to putting a movie together: Capture Video, Edit

fovie, and Finish Movie.

 

 

 “Figure 7-15:
“Windows Movie Maker 2
“sports a new Movie Tasks
“panethatprovides quick
‘access fo the most-used
“Inenu options. The other
“ingjor working areas of the
“program are all identified reathn pardons

 
 

 

 fiere. You'll do most ofyour none
workin the Storyboard or Tapasoa
Timeline view at the bottom

ofthe screen, Meo ors effetsvo Views vider treneihans(ashe thins of ceedite
Make an hoMovie

Windows bowie Maker 2 Windswe Mavie Maker 7
sae! Sample tgoe ‘Batnphe Fae mis

Storyboard view Transition marker

 

 

 
 

 Behindthe scenes, Windows XPcreates a folder in your My Documentsfoldercalled
My. Videos. This is where you'll find icons representing the various video clips that
you‘capture from your camcorder. (You'll also find a few sample videoclips there to

ok around with until you get your equipment-buyingact together.)
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Howyoutransfer footage into Movie Maker for editing depends on what kind of
equipment you've got—analog,digital, or none. 
Capturing footage
To capture footage, hook up your VCR or camcorder to the PC. Then:

1. Choose File—Capture Video, press Ctrl+R,or click “Capture from video device”
in the Movie Tasks pane. 

The Video Capture Device Wizard screen appears, shown at top in Figure 7-16,

he . Click the icon for your camera or capture card. 
If it has multiple input connections,like an S-video connection and a composite
video connection, use the “Video input source” drop-down list to select the one
you want to use. You can also take this opportunity to specify which connection
the sound will be coming from, using the “Audio input source” drop-down list.

we . Click Next. On the Captured Video File screen (second from top in Figure 7-16),
type a namefor the video file you're about to create, and choose a folder for sav-
ing it. Click Next. ,

The Video Setting screen appears, shown third from top in Figure 7-16. °

4. Choose the video quality you want.

Thebigger the resulting movie (in terms of its onscreen dimensions when played
back), the more disk space it will take up. A moviethatfills your screen may look
great on your PC, but you'll never beable to email it to anyone;the video file will
be too huge.

Ifyou plan to showyour movie only on the computer, “Best quality for playback on
my computer”is a good choice.Ifyou hope to exportthe result to your camcorder
(for playback on TV), though, choose the “Digital device format (DV-AVI)”option
(whichis offered oniy if you have a digital camcorder). That’s an extremely disk
space—hungry format, but it preserves 100 percentof the original DV quality.

. Click Next.

 
a

If you're capturing from a digital camcorder, the Capture Method screen now
appears. Here, you can specify whether you want to capture the entire tape (in
which case the camcorder automatically rewinds and thenstarts playing back as
the PC captures) or just selected scenes (in which case you're supposed to use the
onscreen playback controls to stop and start the tape). Click Next.

 
an . On the Capture Video screen (bottom in Figure 7-16), adjust your options.

Ifyou turn on “Create clips when wizard finishes,” Movie Makerwill automatically
chop up the incoming video into individual clips—icons, each representing one
shot you made with your camcorder. If you don't select this option, Movie Maker
will treat all the footage you import as one big video chunk.

7. Click Start Capture.
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“>. If you have a digital camcorder, Movie Maker automatically commandsit to
begin playing; you're essentially controlling the camcorder by remote control. If
you're using a non-digital camcorder or a VCR,it's up to you to push Play on the
equipment. Hither way, you can inspect the video asit arrives on your hard drive
by watchingit in the Preview window. 

 
 

'§, Whenthe recording is complete,click Stop Capture, and then click Finish.

oe You may be asked to wait while Movie Maker processes the incoming footage.

-°9, To capture anotherclip,find it on your tape, and then repeat from step 6 on.

 
 

“poy Figure FIG:
‘|. Top: You sefect the video capture
|" device, audio device, video input
“1hgource, and audio input sourcein

- the Video Capture Device screen.

 
   
 

Wideo Captures Devies
Select the video capture device yor wart fo captete fom and confiege the device d 

 
“ok Second from top:in the Captured
' Video File screen, you name your
_ captured video andselect a folder

ello to store it
 
  

 

  
Captumd Video File

Enter wifornnation fea your captueact video fie,
‘2 Third from top:Select one of three

-” seitings you want to use to capture
2 your video in the Video Settings
= screen, and then verify the selected
“> settings in the information boxes at

the bottom of the screen.

 

 
“Bottom: Finally, you and your tape
are both ready to roll. Use the Start

-. Capture and Stop Capture buttons
- to control the transfer of footage
. fo your hard drive. (ifyou use a
2: digital camcorder, you'll see Play,

: Stop, and Rewind buttons thatlet
Lo: you contral the camcorder right
© from the screen.)

  
 

 Skelect the selting yoo want to ase to mapture yes ideo, The ceptute setting pou celiet
Aetermines the quality and ses of the captued vides.

 

 
 

 
 
 
 

 
  

Capture Video
Click the Stat Capture bullonto begin eaptudig sour video. You can captune one of marevideo clps.
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Repeat this process until you've captured all the pieces needed to create your
masterpiece.

importing pictures and movies
You don’t necessarily need fancy equipmentto fool around with Movie Maker. You can
also bring any movieor picturefile on your hard drive into your Movie Makerproject
by choosing FileImportinto Collections (or clicking “Import video” or “Import
pictures”in the Movie Tasks pane). Movie Makerturnsthefile into a clip, which you
can edit, chop up, or manipulate, as described in the following paragraphs.

 
For example, while waiting for your video-capture card to arrive by mail order, you
can try your handat editing one of the existing movies that comes with Windows
XP. In your My Documents--»MyVideosfolder, you'll find a sample videofile (called
Windows Movie Maker 2 Sample File). After openingit, double-click oneof the clip
icons to watch a convincing home movie of a Microsoft employee’s family romping
at the zoo.

Tip: To the ancient question, “Whatis the sound of one hand clapping?” you can now add, “Whatis the
duration of a still picture?” As far as Windowsis concerned, the answeris, “Two seconds.” When you drag
a stilimageclip into your Timeline, as described below, Windows gives it a wo-second proposed duration.
To make a siill image stay on the screen for a longer or shorter interval, however,simply dragits right-hand
triangle on the ruler, as shownin Figure 7-47,

Editing Video
Once you've accumulated a few clips, it’s time to conduct some general organiza-
tion—rearranging theclips; trimmingoffexcess footage from the ends; addingcredits,
music, and effects, and so on.

Phase 1; Organize your clips
icons for the clips you've imported gather in the Collection area at the center of
the screen. (Behind the scenes, they’re really in your My Documents—My Videos
folder.)

Ifyou chooseView—>Collections,the task pane disappears, replaced by an area where
you can create virtual folders to hold your clips (choose Tools>New Collection
Folder}. Rename or delete these folders by right-clicking them. (You can bring back
the Movie Tasks pane by choosing ViewTask Pane.)

Whenever youclick one of these folders, the middle part of the window showsyouthe
clips it contains. To play oneof these clips, double-click its icon,or click it and then
press the Space bar. (To stop playback before the endof the clip, press Space again.)

Phase 2: Drag them into the storyboard
The clip-assembly area at the bottom ofthe Movie Makerscreen can appear in either of
two ways, depending on your current selection in the View menu(see Figure 7-17):
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+ Storyboard.In this view, each clip appears as an icon,like a slide onaslide viewer.
Eachis the samesize, even if one is eight minutes long and the next is only two. Barone)Cae)

+ Timeline. In this view, each clip is represented by a horizontal bar that’s as wideas
the clip is long. Short clips have short bars; long clips stretch across yourscreen.
Additional parallel “tracks” represent soundtracks playing simultaneously, titles
and credits, and transition effects.

Either way, this is where you'll organize the scenes ofyour movie. Dragthe clips from
the Clips area (shown in Figure 7-15) down into this area to place them in the order

~ you want. You can rearrange them once they’re there, too, just by dragging. You can
- also trim unwanted material off the beginning or end of each clip by dragging the
triangles in each icon.

Figure 7-17:
The filmstrip at the bottom of the
window offers two different views.
Switch between them by click-
ing either the Show Storyboard
or the Show Timeline button. in

Storyboard view (bottom), there’s
no indication of the relative lengths
ofyour clips, but you de get a good
feel for the overall shape ofyour Title Overlay
movie. in Timeline view (top), you
see the relative timing ofeach clip.

Transition
Audio

Audio/Music

el Show Timeline

As you go, you can preview your film in progress by choosing Play->Play Storyboard
(or Timeline, depending on which window youre working with). To interrupt play-
back,click the Pause button in the Preview pane,click Play->Pause Clip, or click
Play—Stop.

Fip: Choose View—Full Screen (or press Alt+Enier) to make the moviefill your monitor as it plays back.
Unless you're working with digital video,the blotchy, biurry enlargement maytrigger your innate demand-
your-money-backinstincts. But this trick is useful, for example, when showing yourfinished movieto a group
of peopie in a room. From a few feet away, the poorpicture quality isn't as noticeable. 
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Phase 3: Chop up the clips
As you work, you may frequently find it useful to cut yourclips into smallerpieces,
thereby eliminating boring material. You can dothis in either of two ways:

* Split a clip, After aligning the scroll bar underneath the Preview pane with the
spot where you wantthe clip chopped, choose ClipSplit, press Ctrl+L,or click ©

‘the “Split the clip” button (shown in Figure 7-15). Movie Maker turns the single =
clip into two differentclips, adding a numberto the nameof the second one. a

Tip: You can do the opposite, toc. After arranging a few clips into a satisfying sequence, you can merge
them into a single, new uni-clip for easier manipulation, To do that, click the first one in the Storyboard ar
the Timeline window and then Shift-click successive clips. Finally, choose Clip—Combine.

+ Trim a clip. Sometimes you just want to trim off unwanted footage from either
end of a clip—a task Movie Makerlets you perform only after you've addeda clip
to the Timeline. Then just drag the triangle handles, which youcan see in Figure
7-7,

Phase 4: Add video transitions

To create a cross-dissolve transition from oneclip to another instead of just cutting,
switch to the Timeline view shown at top in Figure 7-17. Then drag a clip in the
Timeline slightly to the left, so that it overlaps the preceding clip. The amount of
overlap determines how long thecrossfadelasts; adjust this amount by dragging the
clip again. (Dragging the clip all the way to the right, so that it no longer overlaps,
eliminates the crossfade altogether.)

For fancier transitions, click ToolsVideo Transitions (or click “View video transi-

tions” in the Movie ‘Tasks pane}. The available transitions—60 of them—appearin
the Video Transitions pane, shown in Figure 7-18. You can double-click anyof these
icons to see what the transition lookslike. To use one in your movie, drag its icon
down between twoclips in either the Storyboard or the Timeline window.

Tip; It's easiest to drag transition icons when you're in the Storyboard view, because you have such a Dig
target: the big square betweenthe clips shown in Figure 7-18.

Phase 5: Add video effects

A video effect is a special effect: a colorfilter, frame rotation, slow motion,artificial
zooms (in or out), and so on. As with transitions, using them with abandonrisks
making your movie look junky and sophomoric—butevery now andthen,a special
effect may be just what you need for videographic impact.

To view your choices, choose ToolsVideo Effects (or click “View videoeffects” in
the Movie Tasks pane}. You can apply a videoeffect in either of two ways:

+ Drag its icon from the Video Effects pane directly onto the desired clip. (You can
drag more than one onto the sameclip.)
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‘© Right-click the clip icon in either the Storyboard or the Timeline window, then
choose Video Effects from the shortcut menu. The Add or Remove Video Effects
dialog box appears. Ifyou promise to use goodtaste, you can evenpile up multiple

effects on a single clip and rearrange the orderin which they’re applied.
 

fe: When you apply aneffect, Movie Maker 2 applies it to the entire clip. When you split, move,cut, or
copya dlip or picture, its effects remain attachedtoit (or all of its parts). On the other hand, if you combine
{wo clips, the first clip’s effects retain control, and the second clip’s effects are vaporized.

 

 

 

 
 

 

 
 
 

‘Figure 7-18:
Microsoft has provided 60 video
iransitions for your movies, Use

"them to soften transitions from one
dlipto the next—but use discretion.
Going hog-wild with different nutty
transitions in one movie will brand

“you as an amateur, Professional
flimmakers rarely use anything

- beyond a simple cut or a cross-

 
  
 
 
 

 
 

  1, Capure Video|

[2EdtMovie
Show collections
Yiew video effects
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    Make titles oy cradits Diagoaal, Crags Gut
 

 
 

3. FinishMovie

 

 
| MovieMakingTips

 
Diamond

 
 

 

 
 
 
 

 

 

Phase 6: Add titles and credits
extsuperimposed over footageis incredibly commoninthefilm and video worlds.

You'dbe hard-pressed to find a single movie, TV show, or commercial that doesn’t
¢ titles, captions,or credits. In fact, it’s the absence of superimposedtext that pegs

mostcamcorder videos as amateurefforts.

 
   

  
 

Te add this kind oftextin Movie Maker 2, begin by choosing Tools—Titles and Credits
(or click “Maketitles or credits”in the task pane).

shown iin Figure 7-19, you're offered five places to put text: at the beginning of
thenmovie, at the end of the movie,beforea clip, onaclip,or after a clip. Note that in

‘ovie Maker terminology,text that appears before or after a movieis called credits,
and it must take the form of name/job pairs(like “Director: Chris Olson”). Text that
appears just before, after, or superimposed ona clip is justcalleda title.,
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Once you've clicked your choice, youre offered the chance to type the actual text.
This screen also offers “Change the title animation” and “Change the text font and
color”links, which affect how thetitles or credits drift across the screen (and in what
type style). The animationeffects duplicate just about every commonTV title style:
letters flying onto the screen, spinning onto the screen,scrolling across the screen,
and so.on.

 
‘Wheredo‘youwanttowilifa ttle? oe enn - . Figure 7-19:
coe es Top lett: Thetitles and credits

won tenn nnn ~ option offers severaldifferent
aidthieatthebecieesna of Ene move, Serer __ placements for titles and a
Atilebefuratheselectedclaon the storyboard, Se | wayto enter credits for your

video.
Add ttle on the selected chy on the storyboard,

Top right: On the next screen,
f you're supposedto type up

Aeedsthis.end of the movie = | the actual text ofthe credits.
ee Shown here: an example

Larced Files in From upper left, Bias cut bower rightTypingtext cag letter ab a ine & of finalcredits for a student
Scrolls right te left in color band foverlay} & filmBanter fades. in ard out (overlay) *

Addtite after the selected ely on the starebaard.

Middle right: Here’s where
you choose an animation
style for the text: how will it
fly onto the screen?

Bottom: The result can

fook—well, if notprofessional.
then at least familiar. 

Whenyouclick Done, the program switches to Timeline view and adds your text to
the film in progress (Figure 7-19, bottom). On the Timeline,text gets its own block,
which you can double-click to edit. You can also dragits ends to change the beginning
or ending points. In Storyboard view, superimposed text doesn’t show upatall; text
inserted between clips appears as a separate clip.

Phase 7: Add background music
If youre lucky, you may somedayget a chance to watch a movie whose soundtrack
isn’t finished yet. At that moment, your understanding of the film medium will
take an enormousleap forward. “Jeez,” you'll say, “without music and sound effects,
this $100 million Hollywood film has no more emotional impact than...my home
movies!”
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 ‘And you'll be right. Without music, sound effects (called SFX for short), and sound

editing, even the best Hollywood moviewill leave you cold and unimpressed. Fortu-
~ ately, Movie Maker can use any MP3 or WMA file on your hard drive as a musical
: soundtrack. Just choose FileImport into Collections. The music file appears among

our clips with a special musical-note icon.

 
 

 
 
 

 
 

 Now, in Timeline view, drag the music clip onto the track marked Audio/Music. You
andrag the appropriate rectangularstrip left or right to control whereit starts and

ends. Using the Tools—>Audio Levels command, you canalso adjustits volumerelative
tothe camcorder sound. Unfortunately, you can’t create variations along the music’s

length (to make it softer during dialog, for example).

 
  

 

 
 
 

 
 
 

   ip:# Even if you don’t own a camcorder, one of the nicest things you can do with Movie Makeris produce a
: slide show with sound.After importing still images as described earlier, import a pop songto lay underneath

: You'll be surprised at how much impact the result has.

 

 
  
 
  
  

 
al 8: Save the movie

When.your flick looks and sounds good,you can saveit as a stand-alonefile on your
ard drive, which you can then double-click to play or send to potential investors.

 

    

“Todo so, Choose File>Save Movie File (Ctrl+P), or click “Save movie file” in the
ask pane. In the Movie Location screen, specify where you wantto save the movie,

Yowhavefive options:

 

  
 + My Computer. Choosethis optionifyou wantto preserve the complete movieas - = OY

a.file on your hard drive. eo
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* Recordable CD, A wizard appears to walk you through the process of saving a
lower-resolution movie onto a blank CD, so you can distribute it to friends for
playback on their PCs. (These disks will also play back on CD and DVD players.
that bear Microsoft's “High M.A.T.” logo—of which there are very few.) :

E-mail, The Web,Videoreally isn’t a good matchfor Internetdistribution methods;
video files are huge and slow to download. This wizard, then, guides you through.
making a very low-quality, small-framed,slightly jittery movie whosefile sizeis.
small enoughto transmit via the Internet. oo

DV camera. For many people, this is the most important new feature of Movie
Maker 2. While you're editing your movie, you watch your work-in-progress on the
screen—butthat’s only a low-res representation ofthe spectacularclarity ofdigital
video. Fortunately, behind the scenes, every shred ofcrisp, clear, smooth-motioned
videois intact on yourhard drive. To see it, you must export the movie back to ©.
your DV camcorder, where it appears with all of its high-resolution glory.

Oncethefinal production is back on a DV tape, you canplay it on a TV with in- 3
credible quality, or copy it onto your VCR(at much lower quality} for distribution
to family, friends, and Los Angeles agents. *

 
Tip: You can turn any individual frame from your movieinto a stili picture (a JPEGfile). In the Preview pane
(shown in Figure 7-15), watch the footage until you see the frame you want to capture, and then click the ©:
round Take Pidure button (also in Figure 7-15). Windows asks you to name your newly created graphics
file and save it

 
 
WINDOWS XP PRO: THE MISSING MANUAL

HP Inc. - Exhibit 1007 - Page 262:



HP Inc. - Exhibit 1007 - Page 263

 
 

 
 
 
 
 
 
 

 
 

 

The Control Panel

“the Control Panelis an extremely important window in Windows XP. It’s teem-
ing with miniature applications that govern every conceivable setting for ev-

m&. ery conceivable component of your computer. Some are so important, you
mayuse them (or their corresponding notification area controls) every day. Others
are sd obscure, you'll wonder what on earth inspired Microsoft to create them. This
chapter covers them all.

Category View: The Big XP Change
To see your PC’s collection ofControl Panel programs, open the Control Panel window
bychoosing Start>Control Panel.

 
Thefirst time you see the XP Control Panel, you may be in for a shock. Instead of
the list of two dozen programsthatused to be there, there are now onlynine gigantic
icons underthe headline, “Pick a category”(Figure 8-1). 

Microsoft developedthis new designto befriendlier to novices. First click the category
h -ading that you think contains the settings you want to change, such as Appear-
ance and Themes. Now you'll see a second screen (Figure 8-1, bottom) thatlists a
few commontasks in that category: “Change the desktop background,” “Choose a
screen saver,” and so on.

 

At this point, ifyou so desire, open the relevant Control Panel program byclickingits
icon at the bottom ofthe screen (Display, in this example). But by clicking the name
ofthe task instead, you're spared a bit of hunting around, since Windows XP takes

_ you directly to the appropriate tab of the appropriate program.
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Fip:If youinstall software that comes with a Control Pane! program of its own,it may not be smart enough
ta placeitself into the correct category. In that case, you'll find it by clicking the link (in the task pane) called
Other Control Panel Options (see Figure 8-1).

 Figure 8-1:
Top: This new design is
Microsoft's attempt to make
the Controf Panellook less

overwhelming to first-timers.
This arrangement groups
the existing contro!panels
into functional categories.
When you click one of these
headings, you're taken to
another new screen.

Bottom: The next screen

lists the corresponding
contral-panelicons at the
bottom—but, perhaps more
useful to the novice, it also
lists the useful tasks that

those controlpanels handle.

  
  
 

  
 

li. Edit. Hews.) Favorites“sTédls:| Help:

Troubleshestars ’

Restoring the Old Control Panel
If you're a veteran Windows user, the hew arrangement of the Control Panel may
strike you as just another drag on yourefficiency. Afterall, it places anotherlayer of
red tape between you and familiar control panels.
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Fortunately, it’s easy enough to eliminate the “Pick a category”display forever: Just
click “Switch to Classic View”in the task pane (Figure 8-1, top). Now your programs
appearjust as they always have,as a tidy collection of individualicons(Figure 8-2).

The rest of this chapter assumes that you're loolcing at the list in Classic view—the
one that presents an alphabetical arrangement.
 

Tip: ‘f you're really a speed freak, even the Classic View method of accessing a particular Control Panel
program is fairly inefficient,First you have ta choose Start-»Control Panel and wait for the window to open,
then you have to double-click the individual program you want.

 
 

To save time, turn on the feature that lets you choose a certain program's namedirectly from the Start menu,
as described on page 57,

Figure 8-2:
if you're used to the old way
of accessing the Control
Panelprograms, shown here,
a single click on “Switch to
Classic View” (Figure 8-1) does
the trick. Even the standard

Control Panellist (shown here
in Details view} attempts to be Ber Aso
helpful. though—-the Comments
column describes the function

of each program, and tooltips
appear when you point to
programs withoutclicking.

Accessibility Options

instal and troubleshoats hardware ;Instal or remove programs and Windsws compon...
Configure administrative settings For your camgy...
‘Set the date, tine, and tine zone for your comp...
‘Change the apmearanee of your desktop, such a..,

custonane yen eshacotties, such as he ¢LoChistoraie your mouse settings, such as the butt...
Cannects to other computers, networks, and the...
Conkigure your telephone diakag nukis and more...
Tenfigura energy-saving setkings For your compu.
Shows inctalled printers and Fax printers and hel...
Configures GuickTane software and hardware co...
Configures ResiPlayer and related sofiivare
Custenize settings far the display of languages, ...
Add, remove, and configura scanners and camer...
Schadute computer tasks ko run automatically.
Change the sound scheree for your computer, or...
Change sattings For text-to-speech and for see...
See information about your computer system, an...
Customize the Start Meru and the taskbar, such
Changs user attdunt settings end passwords Foy...

 
Most of the optionshere are designed to make computingeasier for people with dis-
abilities, though some options can benefit almost anyone (Figure 8-3).

Keyboard Tab
The Keyboard adjustments makeit easier for some people to type without errors.
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StickyKeys
StickyKeysis for people who have difficulty pressing two keys (such as Ctrl, Alt, and
Shift key combinations) at once.

 
Oncethis feature has been turned on,you can pressasingle key of a specified combi-
nation oneata timeinstead of simultaneously.To doso,press the first key (Ctrl, Alt,
or Shift) twice, which makesit “stick.” Then press the second key (usually a letter key).
Windowsrespondsexactly as though you had pressed the two keys simultaneously.

 
 
 
 
  Figure 8-3:

Double-click the Accessibility Options icon in the
Controf Panel te open the dialog box shown here. You

| start out looking af the Keyboard tab, which offers
i : StiokyKeps Stetoestaat meant rt crannies tamarann a useful ways io adjust keyboard behavior. Clicking any
| Use StickyKeys if you want to use SHIFT, CTRLALT, et | of the Settings buttons allows youto fine-tune many

| Windows fogo key By pressing ane key at a time. 1) ef these features, making it even easier to accammo-
| Fuse Stickytieys ~ Setings date special computing needs. 

 
+ FiterKeys ee ee ee

: Use FiterKeysif you want Windowstd ignore brief or repeated
: keystrokes, or slow the repeatrate. ee. a

Eo] Use FiterKeys:_ oe Se [Settings|

» ToagleKeps

 
  

“pas ‘Use TogaleKeus if you wang te hear tones when pressing :
vy CAPS LOCK, NUM LOCK: and SCROLL LOCK... oe

 Eo]UseTeggleKeys” has te[-Settings

[7] Sho extra Kepboard fielp in programe’:

 

 

  
 

If you click the Settings button, Windows displays a dialog box offering several
useful options. One of them, for example, makes Windows XP beep when a keyis
double-pressed and “stuck”—a confirmation that you're aboutto trigger a keyboard
shortcut.

 

FilterKeys
In Windows, holding down a key for longer than a fraction of a second produces
repeated keystrokes (such as TTTTTTT). When you turn on the FilterKeys option,
Windows XP treats a repeated key as a single keystroke, which can be useful if you
have trouble pressing keys lightly and briefly.

The Settings button lets you access optionslike these:
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shortcut. Requires that you also press the right-side Shift key for eight to
ixteen éeconds as the on/off switch for the filtering mode.

show FilterKey status on screen. Puts a stopwatch-like icon in the Notification
eawhen youre in FilterKeys mode.
 

igleKeys
When you turn on this option, the computer beeps whenever you press the CapsLock,

Lock, or ScrollLock key.
dost have to be disabled to find this option attractive, since the confirmation

beepPevents you from looking upafter five minutesof typing to find a pageof text
f IOOKS LIKE tHIS.

ing-on SoundSentry instructs Windows XP to make your screen flash or blink
‘a’sound occurs—auseful feature if you have trouble hearing. Use the “Choose

ual warning” drop-down list to select which part of the screen you want to
ag a warning:thetitle bar of the active window,the active windowitself, or the

/ ursightiis going, you mayfind that Use High Contrast makes text easier to read.
ec the Settings button to choose white lettering on black, black on white, or any

combination that works for you.

analso use this dialog box to makeyourblinking insertion point (which appears
whenyou'rediting text) easier to see. Use the associated slider to change the blink
rate; the width ofthe blinker, or both. (Makingit fatter comes in especially handy on

tlaptops whose screens aren't the greatest.)

One of the simplest and most powerfulaids to people with failing vision is the “Windows Standard

‘and “Windows Standard (extra large)” Desktop Themes, You'll find these conirols in the Display
5‘Appearance tab, as described later in this chapter. With a single click, you can make Windows

arge ihe font usediin all of its dialog boxes, menus, icon names,tooltips, and so on.
 

Dont miss the Mouse program (page 279), either, where you can select much larger arrow cursors. 

youfind:using the mouse difficult, or if you'd like more precision when using
aphics programs, consider turing on the MouseKeys feature (by turning on the

MouseKeys” checkbox onthis tab, and then pressing the NumLock key to turn
iseKeys mode on and off). It lets you use the number keypad to control the

ow cursor. Pressing the 2, 4, 6, and 8 keys on this pad moves the mouse around
 

CHAPTER 8: THE CONTROL PANEP Inc.- Exhibitt 1007-7-P je267

 



HP Inc. - Exhibit 1007 - Page 268

 
 
 
 
 
 
 
 
 

 
 

 
 
 

 
 
 
 
 
 
 

 
 

your screen—down,left, up, and right. (Check your keyboard for the corresponding :
directional arrows on these keys.)

In MouseKeys mode,the other numeric-keypad keys also have new assignments:

+ Turn on “Hold down Ctrl to speed up and Shift to slow down”to do just whatit
says: make the cursor jump in larger or smaller increments when youpress Ctrl
or Shift, respectively.

* Use the 5 key to simulate a mouseclick (left-click).

+ Use the minus-sign key to simulate a right-click.

* Use the + key to simulate a double-click.

To fine-tune the MouseKeys behavior, click the Settings button. Here’s one useful
fine-tuning option: If youd like to require that theleft-side Alt and Shift keys be
pressed in addition to NumLock (to prevent accidental MouseKeystriggering), turn
on the “Use shortcut” checkbox.Ifyou prefer to use both your numeric-keypad keys
and MouseKeys, set “Use MouseKeys when NumLockis” to Off.

MouseKeysalso offers a way to drag, so you can select text or move objects on the
screen without using the mouse:

1. Use the keypad arrows to position the cursor on the highlighted text, icon, or
whatever you want to drag.

2. Press Ins (the zero key on your numeric keypad).

To “right-drag,” press the minus-sign key, then Ins.

3, Use the keypad arrows to dragto the target location.

4, Press Del on the keypad to “drop”the object.

General Tab

Usingthe settings on the General tab, you can set WindowsXPto turn offaccessibil-
ity optionsif it’s been awhile since you've used them. This setup is also useful when
several people share the same PC on the same account (see Chapter 17), and only 
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ofthem requires these options. You can also ask Windows XP to play a sound or
message to notify you when you turn options onoroff.

General tab also has an option to recognize SerialKey devices: special equipment
usually keyboard and mousereplacements) for people with disabilities.

 
‘AddHardware

g iconiisn’t really a Control Panel program atall; it’s a wizard, andit’s described
apter 14.

dd or Remove Programs
§ program, freshly overhauled in Windows XP,is described at length in Chapter5.

_ offers three or four panels that offer important software-managementfunctions.
 
 

angeor Remove Programs
Thistab displaysa list of every program you'veinstalled onto your PC. To remove one

‘Orn. your ‘system,click its name and then click the Remove or the Change/Remove
ton. Some program packages(like Microsoft Office) offer a Change button,too,so

atyoucan add or removeindividual components—just Excel, for example. When
ickthe Change button,haveyourinstallation CD handy, because the program

ray:askyou to insert it into yourdrive.

 

 

  

dd New Programs
ouwon’t need the first option here (“Add a program from CD-ROM orfloppydisk”)

ryoften, because most software programs come with their own installers. Using
1¢ GDor Floppy button is just a roundaboutwayof launchingthe installer on the
isk you've inserted.

 

heWindows Update button, however, is useful indeed. It takes you to the same
Microsoft Web page as the StartAll Programs—Windows Update command,at
‘http://windowsupdate. microsoft.com. (Figure 8-4 shows what you mightsee.}

ere, you can get a list of the latest updates, bugfixes, and patches that Microsoft has
ased for your version of Windows XP. You'll soon discover that Windows XPis
mstant work in progress; Microsoft seems to come up with anotheroneofthese

xes, patches, or updates every couple of weeks.  
ote thatWindows Update isn’t quite the samething as the Automatic Update feature,
escribed on page 331.

 

Windows Update page generally offers two links: Express Install (updates that
icrosoft considers urgent) and Custom Install (less urgent items). Clicking either

makes the Web page begin a remote-control scan of your PC, whichisalittle bit

reepy.but ultimately producesa list of updates that Microsoft considers appropriate
:forF your copy of Windows.
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Other Gpivine
[Siewinstillation

Ystratar options

Ta PaAS aikd aietet *
CF Prequaritly asked

rs

‘Office Fartily

Your computer it set to recewe
Get the latest undates avalabla tor your computer's operating | Nobllcations when new updates :
sestem, software, and hardware, Windows Ldate scan yas 376 avaiable.
cofmputer ta sae what updates are requied and provides vow sot a tenes to rete odssith a fist of upclates tailored] just for yon, : Pack a Gene to inetd Linear

& Express install (Recommended): high Prority Updatesfe

Chonse the for the fastest upelating. Quickly sean for,download, and instal on the citi” smd security
updates your tofmmlter neat.

23) Customfostalh Hyg7“rou Catena
Cheees this te scars for optional, critical, ancl security
updates your cottpder nears, choose from all thaupdates on the site, and review updates before

YY atel Opie

Wineiows Update is locking for available
ubdates..

File. Edit.. View’ Faverites, Took. Help

adinitistrator opt

“BY ada arch cpa*

Express instal slows you te quickly doaniaad and mnstal only the critcal arid security Gpdates your
: cornparer meets.

Mirensott strangy recorsmencds that you instal the following high priority updates to help keep your
computer upto-riste and secure. To instal these updates, click Instat,

Total uniistes selected: 4 tems, 3.5 MB, 2. Ratfirates ; rsd

 
Security Update for Windows xP (KBE25732}

Security Kndate for Wirktowes XP (KBGoo744)
Security Updatefor Windows %P (KBE40987)
Curnuiative Security Update for Internet Explorer 6 Service Pack 1 (KBSG4707}

 

256: 

 
 Note: The first time you use the Windows Update Web page, it will probably mutter something to you about

having %0 install some special components in order to work right. Sigh and click OK. You'll haveto restart
your PC in the process,but atleast this is a one-time cperation.

Figure 8-8:
Top: Clicking Express
Install instructs Win-
dows to check which

updates you've
alreadyinstalled
(middie). Be patient:
this step can take a
minute or so.

Bottom:After the

scan, Windows
Update shows you
a list of the patches
that Microsoft thinks
your machine lacks.
Click install to

begin the process of
downloading and
installing them. (You
may haveto restart
the PC whenit’s

over.) 
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“To see which updates Microsoft is offering you (and howtoinstall them), see Figure

&4,
AAdd/Remove Windows Components

“Think of this tab as a miniature version of the Windows XP Installer described in
: Appendix A. It affords you the opportunityto install (or remove) a newWindows XP
software component without havingto reinstall all of Windows.

Set Program Access and Defaults
ousee this option only if your PC has Windows XP Service Pack | or 2 installed.It’s

escribed in detail on page 52.

Administrative Tools

this icon is nothing more than a folder containing a handful of very technical diag-
nostic utilities—in fact, only shortcuts to them.You'll find brief descriptionsof these

“toolsin Chapter 16.

Automatic Updates
eepage 331 for a discussion ofthis importantsecurity feature.

 

 
 
 

 
 

 
 
 

 

 

uetooth Devices
luetooth iis a long-delayed, but promising, cable-elimination technology.It’s designed
let gadgets communicate within about 30 feet, using radio signals.

oucan get Bluetooth—either built in or as a slide-in cartridge-—for computers, print-
rs, Palm and PocketPC organizers, Sony camcorders, and so on. Microsoft’s wireless -
eyboard and mouse both rely on Bluetooth. Even some cellphones have built-in
Iuetooth transmitters. And more and more laptop models come with Bluetooth.
n theory, at least, the Bluetooth Devices appears on your PC only ifit has a Bluetooth
ansmitter. (You'll find other Bluetooth programs scattered here and there in the
tart menu, too, as you'll read shortly.)

Tip: whats the difference between Bluetooth and WiFi (also known as 892.13)?
Tue, both features use radio waves to connect equipment wirelessiy, But Bluetooth is a cable-elimination
echnology, used mostly for connecting dissimilar gadgets that are Gose to each other(laptop to cellphone,
almtopto cellphone, and so on). 

ViFi primarily a networking technology, with much greater range (and much greater power consumption),
connect palmtops and laptops to each other and to the Internet.

can use Bluetooth forall kinds of things. Among the most popular:
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This is a huge convenience when you want to send ringtones to your cellphone
from your PC,for example, or to download photos from a cellphone camera.

 
  

PocketPGs and ather PRAs

a Palin TS
ers[workstations, servers,laptops. PDAs)

 

  

 

 
 

 

iFgow don't nae the devicé that pots wad to add, make ate thet i fener! oni Fetlow
“ nebup intinclioneWat camewith the deview, atidthen ofekSearch Agary002"
 

Name: fainiacjsa : :
fGed: {EG image Le
Slag; 40.7 KE LE

:
E
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: Inter-gadget communication. Because Bluetooth is inexpensive and usesverylittle

power, it’s particularly popular in handheld devices, like connecting a cellphone

+ Send files between gadgets. Bluetooth lets you shoot files between computers no
matter what the operating systems involved—Mac, Windows, Palm, Pocket PC,
whatever—withoutwires or configuration. Figure 8-5 shows you the ropes.

 

Figure 8-5:
if your PC has Bluetooth, start by choosing Start>
All Programs—>Accessories—>-Communications—>
Bluetooth File Transfer Wizard.

Top: When youclick OK on the welcome screen,
you get this screen, listing afl the Bluetooth equip-
ment you've “paired” as shown in Figure 8-6. If the
computer or gadget you wantisn't listed, click Search
or Search Again.

(The other device must have Bluetooth, must be
turned on, and must be “discoverable.” You'll find the
Discoverable checkboxin the device’s preferences.)

in this example, you're sending a photo from your
laptop ta a Macintosh laptop.

Middle: the recipient sees a message like this and
dicks Accept.

Bottom: On your machine, you see the file Hying
throughthe air. A message of congratulations ap-
pears when the transfer is complete.

(ifsomeone sends you a file this way, you'll find it in
your My DocumentsBluetooth Exchange Folder.)

Now, Bluetooth isn't especially fast—in fact, it’s
pretty slow. (You'll get file-transfer speeds of30 to
50 Kper second, depending on the distance and the
hardware involved.) But when you consider the time
you'dhave taken for wiring and configuration using
any other connection method, you mayfind that
Bluetooth wins.  
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“<> (This is fo preventstrang-

 

 
 to a Bluetooth headset {thefirst Bluetooth combothatreally caught on). No more

“clumsy wires, which is a godsend when youre driving andtrying to avoid hitting
“pedestrians.

 
 °° Figure 8-6:

The fife cycle of a Bluetooth
+~ connection. (The dialog boxes

-> shown here are the standard
Microsoft offerings, but your

* Bluetooth adapter may come
o> yith its own, different-looking

-software.)

“op: You open the Bluetooth
°° Devices controlpanel, it lists alf
"ofthe other Bluetooth gadgets
- your PC has met so far (in this
> case, an Apple laptop). But you
© want to pair your PC with a

“new palmtop, so you click Add.

 
 
 

 
 

  

 
 
 
 
 
 

 
 
 
 
 
 

 

 

 

 
 
 
 
 

 

: Second from top: After a
~ moment, your PC finds the

’ Palm, which you've made sure
=: is turned on andis “discover

SS able” (you've done thatin
.. Preferences).

 Do pou aved a passkey to add your device?

  
 
 

“2 Third: Windows asks you to
“make up (or offers to make

~ up) @ one-time passkey. You'll
’ fave to enter the same one

- when the dialog box (shown
~: at right) pops up on the Palm.

‘ol enviar this quedtion, tefer la the "Blu oth
Sots device:IE the dockiriarlation seciies & panna: tidehake 
 
 
 

 
 
  
 

Enter passkey for
200;
 “ers from hooking into your

“ Bluetooth gear without your
: knowledge—someone using
a laptop to makecalls using

~~ the cellphone in yourpocket,
for example.) You have 60
seconds to comply.

 
  
 

CF Addte trusted device tet.

  
 
 

 
 

 
 

> Bottom: if the pairing is suc-
> cessful, the Palm now appears

~ in the Bluetooth Deviceslist.
Pain 15

Computers(workstations, servers, laptops, PDAS]

 

  
) At this point you'd change
) your palmtop’s synchroniza-

’ tion settings to make them
use the Bluetooth COM parts

“> when syncing. (The same steps
’ outlined here would apply to a

PocketPC, by the way.)
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More examples: You can reduce clutter by buying a Bluetooth keyboard and mouse.
(from Microsoft, Logitech, and others), or sync your Palm or PocketPC without
wires or cradles. 

¢ Wireless Internet.Ifyou have a Bluetooth cellphone, you can make Internetcails
from your laptop or palmtop, without even taking the phone out of your pocket. ©
(You may haveto sign up for a $pecial Service plan from yourcell carrier.)

* Wireless GPS. Place your Bluetooth GPS (Global PositioningSatellite) receiver on |
the dashboard of yourcar, and then use yout palmtop or laptop for navigation.

 In anycase, here’s a quick overview ofthis panel’s two most importanttabs:

* Devices. Here’s where you introduce other Bluetooth equipment to your PC. Click ©
Add to fire up the Bluetooth Setup Wizard, which scouts the local airwaves for -
Bluetooth gear in your vicinity and lets you add them to your PC’slist. Figure 8-6
illustrates the process.

 

 
Whensecurity is an issue—like when youplan to use your Bluetoothcellphoneas
a wireless Internet antenna for your laptop, and you'd just as soon not have other
people in the airport waiting lounge surfing the Webvia your cellphone—you can
opt to pair your laptop with your phone(the passkey process illustrated in Figure
8-6). Once that’s done,you're free to use the phone’s Internet connection without
any further muss, fuss, or passwords.

 

Options. Here’s where you make your PC discoverable (thatis, “visible” to other
Bluetooth gadgets). Once you've paired your Bluetooth gadgets, like your laptop
with yourcellphone,it’s a good ideato turn this option off, so strangers can’t tap
into your Bluetooth gear.

You also get a “Show the Bluetooth icon in the notification area” checkbox, so that
you'll be able to check your Bluetooth settings faster the next timeit’s necessary.

Setting up your PC to talk to a particular Bluetooth gadget can beeffortless (as with
a Microsoft Bluetooth mouse, which comes with an easy-to-use installer) or it can
take a Saturday of cruising Web pages for tips and tricks (as when you're trying to
make your laptop communicate with a particular cellphone model, and you have to
sleuth around until you find the proper modem settings). Butit’s all in the name of
eliminating the world’s cables, and that’s a very good thing.

Date and Time

Your PC’s conception of what time it is can be very important. Every file you create
or save is stamped with this time, and every email you sendor receive is marked with
it. When you drag a documentinto a folder that contains a different draft of the same
thing, Windows warnsthat you're about to replace an older version with a newer one
(or vice versa}—butonlyifyourclock is set correctly.

This program offers three different tabs:
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: S Date & Time. To set the date, choose the month andyearfrom the drop-down lists,
Sovand then click the correct calendar day square. To set the time, see Figure 8-7,

“ + Time Zone.This tab presents a world map—onethat might tempt youtoclick to
°. indicate your location on the planet. This display, too,is just for decoration; use
_. the drop-down list aboveit to specify your time zone.

 
  

 
  
 

 
J: Figure 8-7.
°. To specify the current time, don’t bother drag-

: | ging the hands of the clock—they’re just for
“. decoration. instead, click numbers in the time
‘|: box, and then changeit by typing numbers,

“> pressing the up or down arrow keys on your
* keyboard, or by clicking the tiny up or down
: arrow buttons. To jump to the next number for
setting, press the Tab key.

  
   

  
 

6
11 12 13 14
18 19 20 21
25 26 27 28

‘© Internet Time. By “Internet Time,” Microsoft isn’t referring to the recent, fanciful
notion ofa single, global timekeeping system (in which each dayis divided into
1,000 equal time units). Instead,this tab lets you teach your PCto set its own clock
by consulting a highly accurate scientific clock on the Internet. To activate this
feature, turn on “Automatically synchronize with an Internet time server,” choose

_ one of the time server Websites listed in the Server drop-down list, make sure
“= yowre online, and then click the Update Now button. (No need to worry about

. Daylight Savings Time,either, as the time servers take that into account.)

 

 

 

 
 

’ Mate: Your PC wilt set its dock again once a week-—if it's connected to the Internet at the time.If not, it will
“give up untthe foliowing week. !f you have a dial-up modem,in other words, you might consider connecting

- to the Internet every now and then, and then using the Update Now button ta compensate forail the times
-_ your PC unsuccessfully tried to set its own clock, 

. Display
"Have you ever admired the family photo or Space Shuttle photoplastered across a ca-
“.”, worker's monitor desktop? The Display icon—oneofthe most important programs

“on your PC—is your ticket to such interior decoration stunts, and many others.
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This icon opensinto a window(see Figure 8-8) whose controls are then divided into
five tabs: Themes, Desktop, Screen Saver, Appearance, andSettings. 

 
Tip: Here's a quick way to open the Display program: Right-click any blank spot on the desktop and choose
Properties from the shortcut menu. 

figure 8-8:
Lowerright: Here's
a tool chest filed

with everything
you need to
change the look of
your desktop, In
addition to redeco-

rating the desktop,
you can even redo
the design scheme
used for the

windows you open
as you work.

iMiddle: The Desk-

top tab jets you
A themeis a backgroundplus 2 set of counds, iecne_ ond ather slemerits choose ga picture toto help pou personals your computes wath one click,

plaster onto your
desktop backdrop.

Upperleft: Some
screen savers are

animated: they
ee t move, grow, oF

[EusanizeDecitan.,_}appear with fade-
g in effects. The My

Pictures Slideshow
shown here, for
example, offers an
endless slide show.

 
Themes Tab

Past versions ofWindowsletyou change the backgroundpicture for your desktop,but
that’s kid stuff. This tab, new to WindowsXP,lets you radically change the look and
emotional tenor of yourentire PC with a single click (see Figure 8-8, lowerright).

Each of the themes listed here comes with a color scheme, font selection for your
menus and dialog boxes,pictures for use as desktop icons, sounds, cursor shapes, and
a desktop picture. (These special desktop pictures, by the way, are bonus backdrops
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“that aren't listed in the Desktop tab, described next.) Now you know whyit’s so easy
-- for people who don’t care for the new, blue WindowsXP graphic-design lookto switch

pack to the old design—since each look is nothing more than a Theme.
 

- Meter Choosing “More themesonline”fram the Theme drop-down fist does indeed take you to a Microsoft
Web page where you can download additional themes—aswell as additional screen savers, games, and so
‘on. But these aren'tfree. In fact, they're part of the $40 Microsoft Plus pack. (Operators are standing by.)

: ft’s easy enough to design a new Theme of your own, however. Just use the other
tabs in this program to set up the desired appearance of your PC screen, complete

with your choice of desktop background, menu and windowfonts, icons, and so on,
‘exactly as describedin the following pages.(Visit the Mouse and Sound programs in
‘the Control Panel,too,to select cursor shapes and beep sounds.)

"Then return to the Themes tab and click the Save As button. Finally, give your new
‘theme a name,so that you cancall it up whenever youlike.

‘Desktop Tab
Your desktop’s background surface doesn’t have to show a sunlit hillside forever. You
can very easily decorate it with a picture, pattern,or solid color.

‘Applying wallpaper
-Wallpaper, in Windowslingo,is a picture that you can “hang”on yourscreen backdrop.
Click one of the namesin the Backgroundlist box (Figure 8-8, middle) to see howit
looks on the miniature monitorin the dialog box. You'll quickly discover that Windows

is blessed with some of the most spectacular full-screen photos ever amassed,
cluding close-ups of flowers, the moon, spacey-looking ripples, Stonehenge, and
veral desert shots that some photographer must have sweata lot to capture.

 
ip: Not everything in the Background list box is a photo. Many of them are repeating patterns. Choosing

oneof these leaves a bit more memory in the PC pot for use by your programs. 
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If nothingin thelist excites you, use one of your own graphicfiles as wallpaper, such
as a scanned photo of your family or your family dog. Thenclick the Browse button
to find the file you want. You can use any graphics file with one of these extensions:
-bmp, gif, jpg, jpeg. _png, -dib, .htm, or .btml.

 
If the graphicis a small picture, you can specify how you want Windowsto handleit
by choosing one of these commandsfrom the Position drop-down list:

* Center puts the graphic right smack in the middleof the screen, surrounded bya
margin of whatever color you choose from the Color drop-down menu.

+ Tile multiples the image, repeatingit until it fills the entire desktop.

* Stretch distorts and expandsthesingle imageto fill the desktop, sometimes with
coarse and grainy results.

After selecting a backdrop youlike, click OK to apply it and close the dialog box. Or,
to preview the wallpaper on your desktop, click the Apply button, leaving the dialog
box open so that you can make another choice if the first one looks hideous.

To remove wallpaper, return to the Display Properties dialog box and select (None):
at the top of the Backgroundlist box. Whatever color you've chosen in the Color
drop-down menu reappears on your desktop in place of the wallpaper.

Solid colors

To change the color of your desktop without putting a picture there, click (None) in
the Background list, and then choose a color from the Color drop-down menu.

The “Customize Desktop” Button
Clicking the Customize Desktop button at the bottom ofthe Display Properties dialog
box takes you into an absolutely enormous world of additional options. Thefirst thing
yousee after clicking Customize Desktop is the General tab.

General tab

A better name for this tab might have been “Desktop icons,” since all of its options
pertain to the icons that sit, or don’t sit, on your desktop.

 * Desktop icons. Microsoft is on a crusade to clean up the desktop. “The Start menu,”
its designers seem to say, “is the proper launchingbayfor openingfiles, programs,
and folders. The desktop is just a placemat—so keep it clean”

That’s why mostofthe desktop iconsthat appeared in previous versions ofWindows
no longer appear on the desktop in Windows XP. This is Phase I of Microsoft’s
campaign to keep the desktop clean.

If you want My Documents, My Computer, My Network Places, and Internet Ex-
plorerto sit out on your desktop, you must put them there yourself{—by turning on
the corresponding checkboxeshere. (They also return to the desktop automatically
when you switch the Start menu to its “Classic” view, as described.on page 25.)
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 + Change Icon. The middle section of the dialog box lets you change the pictures

that Windows uses for the important desktop icons. If, say, you can’t stand the
look of the Recycle Bin icon,click it in this scrolling list and then click the Change
Icon button.You'll be shown an assortmentofpotential replacement images. And
if you've created or downloaded additional miniature pictures, you can use one
of those by clicking the Browse button andnavigating to the folder that contains
them.

  
  

  
  
 
 

 
 
 

 

 
 Figure 8-9:

. Windows doesn't actually
delete anything when it cleans
away shortcut icons for your
desktop. it just moves them

- inte a folder called Unused
Desktop Shortcuts (also on

| your desktop). You don't have
- to wait 60 days to reap the

.. benefits of this little software
" fanitor—just dick the Clean

_ Desktop Now button in the
- Displayprogram—Desktop

ES tab—Customize Desktop
“+ button—>General tab. (Or, if

“i. tS easier, just right-click the
:- desktop and choose Arrange
' Joons ByRun Desktop Nowe
-! Cleanup Wizard from the 9/3/2002
Shortcut menu.) Never
TEED i Snagit Studio 6 Never

  

 
 

 

 
 

Weicome to the Desktop Cleanup
Wizard 
  
   
 

This wizard helps you clean up your desktop by meving
unused shortcuts ta a desktop folder caled Unused
Desktop Shortcuts.

 
 

 
 

 
 
 

 
 

  
  Shortcuts

The shortcuts selected below will be moved to the Unused Desktop Shortcutsfalder,  
 

 
  
  
  
 

 

 
 

 
 

 
  
 
 

 
  

 
  

Desktop cleanup. Phase H ofMicrosoft's clean-up-your-desktop campaign involves
the Desktop Cleanup Wizard. Every two months, a message pops up on yourscreen,

_ offering to sweep away any desktop icons that you haven't used in a while (Figure

 
   ‘course, receivinglive, continuous Internet information requiresa live, continuous

Internet connection. It’s great if you have a cable modem or DSLline, for example,
‘bat less practical if you dial the Internet using a modem. 
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Once the Webtab is in front of you, turn on a checkbox in the Web Pageslist box
(such as “My Current Home Page”). 
Thesecheckboxes represent the various Web pages you'dlike to see plastered across
your desktop. To add to thislist, click the New button, type the Web address, and
click OK.

You can add any kind of Web information to your Active Desktop. Frequently up-
dated pageslike stock tickers are popular, but you can also use Web pages that don't
change much.

In fact, by clicking New and thenthe Visit Gallery button, you can check out the Mi-
crosoft Website, which offers an array of newsy, constantly updating Active Desktop
elements—suchassports, weather,or travel news-—that have been specially designed
for desktop use. Thatis, they aren't actuallyWeb pages, but blurbsthat appearin their
own litde boxes on your living desktop.

 

Andif you click the Browse button in the New Desktop Item dialog box, you can
choose a graphics file or HTML (Web page document) on your hard drive for dis-
playing on the desktop.

 
 

Tip: Here's something to tuck away for future Web-browsing sessions. Whenever you stumble onto a Web
pagethat might make a good Active Desktop display, right-click its page—right there in Internet Explorer—and
chooseSet as Desktop Item from the shortcut menu. You've just added a new option without fiddling around
in the Display program.
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 “No matter how you select your desktop Web material, however, the process always

“ends with an “Add item to Active Desktop” confirmation box. It identifies both the
“name and the URL (Web address) of the page you've selected. It also contains a Cus-

tomize button, whichlets you specify how often you want your PC to update the Web
~. page information with fresh data from the Internet. (Later, you can always adjust the

_ schedule using the Properties button on the Webtab ofthe Desktop tab ofthe Display
» program in the Control Panel.)

 
    
   
 

 
 

When you click OK, a strange thing happens: Your entire desktop becomes a Web

browser. Here's what you can do now:  "+ Click links. Web page material now appears directly on your desktop, complete
“swith pictures, text—and links. Clicking one of theselinks takes you to a new Web

page, exactly as in a Web browser—in fact, it will be in your Web browser, which
“opens automatically. You can actually surf the Web using the pages plastered to
“your desktop.

 
  

   
  
 Move the page. By pushing your cursor to the top of the Web page area, you can

even makea little title bar/menu bar appear.Just dragit like a handle to move these
little Web windows around the screen.(If you right-click outside the Web page

“© portion of your desktop, you can choose Arrange Icons By->Lock WebItems on
_ © Desktop from the shortcut menu. You've just frozen the size and position of your
“Active Desktop windows. Repeat this process to unlock the positions.)

 
  

   
   
 
   boFigure 8-10;

E == The Controlmenu of
“each individual Active

=. Desktop window
“contains useful com-

-mands, To make the
“menu appear, push

your cursor close to v Make Avaieble offing
“2 the top ofthe mini- :
“page.

The Investorticker

. (top) worksa little bit eset to Ongnabsue
_ differently. Click Cus- Spit Desktop With Icons

_-tom fo type in stock
“symbols you want to
2. track; click the tiny
-square fo pause the
2Inotion of the text.
2 This item doesn't

offer the usual mini-
“cimenubar, Control menu Fillscreen Fill screen, but don’t Close Web

coverleft-side icons window
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+ Enlarge the page. To makea little Web snippetfill your entire screen, or only the
part unoccupied by icons, simply click one of the Fill Screen buttons shown in
Figure 8-10. Of course, you can also drag the lower-right corner of a Web window
to makeit larger or smaller.

  
 

 
* Update the page. Unless you've set up a schedule, as described in the box below,

your Active Desktop windows don’t automatically update themselvestoreflect the
latest stocks, weather, and so on. To update the information, open the drop-down’...
menu shown in Figure 8-10 and choose Synchronize. ,

  
  

 
 

o Content to dawnload:

: Download pages :

 
 
 

£4] Follow links outside of Os page's Web site

: {$1 Limit hard-disk usagefor this page tor  
 

 
 

[TWihen this page ctienges, send e-mal te 
 ‘if Uha ate relive9 Ggur'naind dd 0S

password). jt
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Tip: The usual Internet Explorer menu bar doesn’t appear when your desktep is a browser. Therefore, you
won't find standard commandslike Back, Forward, Add to Favorites, and so on.

> Butif youright-click the desktop, a special shortcut menu appears that contains all of these important Web-
“browsing commands. 

- ‘To turn off a particular Active Desktop window, choose Close from its drop-down
o>» menu (shown in Figure 8-10). You can also turn it off in the Display program,of
“2 course.

 
 
 

 
 
 
 

 
 

-»Screen Saver Tab

- You don’t technically need a screen saver to protect your monitor from burn-in.
” Today’s energy-efficient monitors wouldn’t burn an imageinto the screen unless you
~ Jeft them on continuously, unused,for at least two years, accordingto the people who
“actually design and build them.

No, screen savers are mostly about entertainment, pure and simple—and Windows
 XP’s built-in screen saver is certainly entertaining.

. The idea is simple: A few minutesafter you leave your computer, whatever work you
- were doingis hidden behindthe screen saver; passers-by can’t see what’s on the screen.

“To exit the screen saver, move the mouse, click a mouse button,or press a key.

<Fip: Moving the mouseis the best way to get rid of a screen saver. A mouse click or @ key press could trig-
“ger an action you didn’t intend~such as clicking some button in one of your programsortypingtheletter

: whose key you pressed,

» Choosing a screen saver
To choose a Windows XP screen saver, use the Screen Saver drop-down list. A miniature
“preview appears m the preview monitor on the dialog box (see Figure 8-8, top).
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Tip: If you have graphics files in the Start»Documents—>MyPictures folder, select the My Pictures Slideshow,
Windows XP puts on a slide show that features your My Pictures images one at a time, bringing each to ~-
the screen with a specialeffect ¢flying in from the side, fading in, and so on}. You can also cick the Browse .
button to choose a different folder full of pictures,

To see a full-screen preview, click the Preview button. The screen saver display fills
your screen and remainsthere until you move your mouse, click a mouse button, or -
press a key.

The Wait box determines how longthe screen saver waits before kickingin, following
the last time you moved the mouseor typed. Click the Settings button to play with
the chosen screen saver module’s look and behavior. For example, you may be able
to change its colors, texture, or animation style.

At the bottom ofthis tab, click the Power button to open the Power Options Proper-
ties dialog box describedlater in this chapter.

 
Appearance Tab
Windows XP includes a numberof schemes: predesigned accent-colorsetsthat affect
the lookofall the windows you open, (Don’t confuse schemes with Themes, ofwhich
schemes are just one portion.) These color-coordinated design schemes affect the
colors of your window edges,title bars, window fonts, desktop background, and so
on. Theyalso control both the size of your desktop icons and the font usedfor their
names (as shown in Figure 8-11), and even the fonts used in your menus.

The factory setting, called “WindowsXP style,” creates the sunlit blue look ofwindow
title bars, the new rounded shape of OK and Cancel buttons, and so on. By choosing
“WindowsClassic style” from the “Windowsand buttons” drop-down list {Figure 8-
11, left}, you return your PC to the visual look of Windows Me/Windows 2000.

 
 

Figure 8-13:
Left: For the full arsenal

ofdesign-scheme con-
trols, choose “Windews
Classic style,”as shown
here, before clicking the
Advanced button.

Right: As you click
parts of the viewpane,
the item list identifies

what you clicked (such
as Desktop, Scrollbar,
and so on). Then use
the drop-down lists to
choose colors and type
sizes for the chosen
interface elemeni.
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You, the interior designer
“2. The real fun, however, awaits when you choose “WindowsClassic style” (Figure 8-11,

left) and ther click the Advanced button. Nowyoufindyourself in a dialog box thatlets
you change every single aspect of this scheme independently (Figure 8-11, right).
 

Note: Microsoft puta lot of work into the new look of XP, and doesn't want peopiediluting it with their own
. random changes. “If you want the XP look,” the companyis saying, “it’s all or nothing.” The bottom line: If

= & ~ “Windows XPstyle”is selected in the “Windows and buttons"list (Figure 8-11, left), the changes you make
Sei inthe Advanced box (Figure 8-9, right) generally have no effect whatsoever.

 
 

~ Proceed with your interior decoration crusade in either of two ways:

+ Change the elements of the scheme one ata time.Start by choosing from the Item
drop-downlist (or by clicking a piece of the view pane, as shown in Figure 8-11).
Then use the Size, Color 1, and Color 2 drop-down lists to tailor the chosen ele-
ment—such as Desktop or Scrolibar—tosuit your artistic urges. 

+ Someof the screen elements namedin the Item drop-down List have text assaci-
ated with them:Icon, Inactive Title Bar, Menu, Message Box, ToolTip, and so on.
When you choose one of these text items, the Font drop-down list at the bottom
of the dialog box comestolife. Using this menu, you can change the typeface(font,
colos, and size) used for any of these screen elements. If you have trouble reading
the type in dialog boxes (because you have a high-resolution, tiny-type screen), or

: you wish your icon names showed upa little more boldiy, or you'd would prefer
amore graceful font in your menus, these controls offer the solution.

 
-.Tfyoucreate an attractive combination of colors and typesizes, rememberthatyou can

- preserveit for future generations. Click OK to return to the Appearance tab,click the
*: Themestab, and then click Save As. You'll be asked to name your creation. Thereafter,
- you'll see its namelisted alongside the “official” Microsoft themes.
 

 
 
 

 
 

. Effects

— >) Effects is the other button on the Appearance Tab.It takes you to a dialog box that
.~ Tets you control what Microsoft calls special effects in Windows XP.

. Now, these aren’t exactly the kind of special effects they make at Industrial Light and
. Magic for use in Star Wars movies. On the contrary, they're so subtle, they're practi-
. cally invisible. Nevertheless, here’s what you'll find:

-'* Use the following transition effect for menus and tooltips. When this box is
-. checked, menus,lists, and tooltips don’t just pop open whenclicked; instead, they
. gracefully slide open—anattractive, but time-wasting,effect. (Try it on your Start
. menu.) The drop-down list allows you to specify whether you want them to fade

- into vieworscroll into view.

ol If the checkboxis filled in with a solid color, then the transitions are turned on for
some elements (like menus), but not for others (like tooltips).
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* Use the following method to smooth edges of screen fonts. When fonts are
enlarged, they becomeragged on the curves. But when you turn on this option,
Windows XP softens the curves, makingall text look more professional (orslightly
blurrier, depending on yourpoint of view; see Figure 8-12).

 
 

 

 
  

  
   
    
  
  
  
  
  
  

Figure 8-32:
Using the drop-down list
you can choose a smooth-
ing technologythat’s new
in Windows XPsome-

  

    
  
  

wold change. For inside the limousine was
no ordinary passenger, If was prominent
Hollywood casting scout Gatber “Slats”MeGibbons,

would change, For insite the lirnousine was
no ordinary pasdenger, Tt was prominent
Hollywood casting seout Gerker “Slats”MGibbons,

  
 

| Chapter XIV; The Big Break Chapter XIV; The Big Break thing called ClearType. It’s
| / a ok oo designed especially for
| In wohich Tomfords his true talent In awhich Toon finds Fes true inlent flat-panel screens, includ-: ,
| By January 1975, Tom Cruise was growing By january 1975, Tom, Cruise was growing img the ones on laptops.

increasingly unhappy with his job at the gas witreasingly unhappy withhis job at the gas By changing the colors of
i station. Hig hands wera calloused, the work | station. His handswere callowsed, the work the individualpixel on the
| was monotonous, and the furnes were getting: was monotonous, and the fumes were getting adges ofcertain letters,to him, to him, ; ,, ome ° it makes the type appear
| Butit wasn't until the sleek, white streich fimo|Buttwasn’tuntil the sleek, white stretch limo ta be smoother than it

pulled in for five gallons of Premium and a pulled in for five gallons of Premium and a really is,

:

chack underthe hood that Torn knew his life check under the hood that Tom knew his life

 

 
* Use large icons. This checkbox refers to desktop icons. If you're having trouble

seeing your desktop icons, turn on this option to produce jumbo icons. Factory
setting: Off.

Show shadows under menus.Take a look: In Windows XP, open menusactually
seem to cast faint, light gray drop shadows, as though the menuis floating an
eighth of an inch abovethe surface of the window behindit. It’s a cool, but utterly
superfluousspecial effect that saps a tiny bit of speed from the proceedings. This
checkboxis the on/off switch. Factory setting: On,ifyour PC belongsto a network
domain; Off otherwise.

*
Show window contents while dragging.If this option is off, when you drag a win-
dow,a faint outline of its borderis visible; you don’t see all the itemsin the window
comingalongforthe ride. As soon as you stop dragging, the contents reappear.If
it’s on, however, as you drag a window acrossyourscreen,youseeallits contents,
too—which can slow the dragging process on slower machines. Factory setting:
On.

Hide underlined letters for keyboard navigation until I press the Alt key. This
option refers to the small underlines that appear on certain letters in menus and
dialog boxes, somethinglike this. These are designed to help you remember the
keyboard shortcuts for those menu commands.It’s remindingyou thatbypressing
the Alt key along with the underlinedletter, you can choose the corresponding
menu command without even using the mouse.
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In Windows XP, however, these underlined letters are hidden. They don’t appear
“until you actually press the Alt key (or the Tab key, or an arrow key), whichtells

Windows XP: “Td like to use my keyboardfor navigating now,please.”

The factory setting is On. If you turn off this checkbox, the underlines appearall

oeathe time, exactly as in older editions of Windows.

‘The Settings tab (Figure 8-13) is where you can ensure that Windows XPis getting
the most out of your video hardware.

Figure 8-13:
© All desktop screens today, and even most laptop
=) screens, can make the screen picture larger or Appearance} Settings |
“= smaller, thus accommodating different kinds of rath nentSeanaareca =
~ work, Conducting this magnification or reduction

entails switching among different resolutions (the
“ number ofdots that compose the screen),

d ©Display: : Pea hs
a Default MonitorottNeoMagic MasohZanY driver. :

: alforqual
{Hiigh(2¢{24 bit}

+ [roubleshost.. | 

 

 

  
CHAPTER 8: THE CONTROL PANEL

HP Inc.- Exhibit 100 2 :Page 287



HP Inc. - Exhibit 1007 - Page 288
274

Screen resolution

The “Screen resolution”slider snaps to the various possible resolution settings that
your monitor’s software driver makes available: 800 x 600, 1024 x 768, and so on.

Whenusing a low-resolution setting, such as 640 x 480,thesize of the pixels (dots)
that comprise your screen imageincrease, thus enlarging the picture—butshowing
a smaller slice of the page. This setting is ideal, for example, when playing a small
movie so thatit fills more of the screen. At higher resolutions (such as 800 x 600 or
1024 x 768), the pixels decrease, reducing the size of your windowsandicons, but
showing more overall area. Use this kind of setting when you wantto see as much
screen area as possible: when working on two-page spreadsin a page-layout program,
for example.

Color quality
Today’s monitorsoffer different color depth settings, each ofwhich permits the screen
to display a different numberofcolors simultaneously. This drop-down list varies by
video driver, but generally offers settings such as Medium (16-bit), which wascalled
High Color in previous versions of Windows; High (24-bit), once known as True
Color; and Highest (32-bit).

In the early days ofcomputing,highercolorsettings required a sacrifice in speed. Today,
however,there’s verylittle downsideto leaving your screen at its highest setting. Photos,
in particular, look best when youset your monitorto higher quality settings.

The Low (8-bit) option—ifyou even have it—makes photos look blotchy.It displays
only 256 colors on the screen, and is therefore useful only for certain computer
games that, having been designed to run on ancient PCs, require the lower color
setting. (In any case, you shouldn’t set your whole system to 256 colors just to run
these older games. Instead, you should use the new compatibility mode described
on page 120.)

Multiple monitors
Ifyour PC has two or more graphics cards, one graphics card with multiple connec-
tions, or a standard laptop video-out connector, you can hook up a second monitor
or a projector. You can either display the samepicture on both screens (which is what
you'd wantifyour laptop wasprojecting slides for an audience), or create a gigantic
virtual desktop, moving icons or toolbars from one monitor to another. Thelatter
setup also enables you to keep an eye on Webactivity on one monitor while you edit
data on another.It’s a glorious arrangement,evenifit does make the occasional family
memberthink you've goneoff the deep end with your PC obsession.

Whenyou have multiple monitors attached,the controls on the Settings tab change;
it now displays individual icons for each monitor, as shown in Figure 8-14. When
youclick a screen icon,the settings in the dialog box changetoreflect its resolution,
color quality, and so on.
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Tip: Don't have the cash for three more monitors? Then try the next best thing: a software version, courtesy
-‘of PowerToys for Windows XP, Microsoft's free goody bag of extra features (available from wwwmissing

~ mranuals,com).

“: Powertoys includes Virtual Desktop Manager, a new iaskbar toolbarthatgives you four side-by-side virtual
monitors. Zach screenful can haveits own background picture and holds its own set of open programs and

- windows. You can switch from one desktop to the next by pressing a keystroke of your chaice, or by clicking
“the 1, 2, 3, or 4 buttons on the Desktop Manager toolbar.

’ Figure 8-14:
One monitor is considered the primary monitor.

This is the screen that will display your opening Deskiop| Screen Saver
. Windows XP screen, the Logitt dialog box (ifyou a

_ use ore), andso on. Drag the monitor icons to match the physical anangement of your monitors.

ppearance| Settings
Be

When youfirst start out, you'll probably see the
same picture an both screens. But what ifyou'd

- |. dike monitor #2 tto behave as an extension of.
“monitor #1, rather than a mirror ofit?

° ff you have a laptop, press whichever function key
. |. (FIO, say) the manufacturer has designated to put

- an image only on the built-in screen. Now click
screen #2’s icon, and turn on “Extend my Win-
dows desktop onto this monitor.” When you click

.. Apply or OK, you'll have a lot more screen real
estate for your windows. (ifscreen #2 stays dark
of displays an error message, lowerits screen

resolution and try again; your video cardprobably - Elsetisdeviceae theprimar z wot4 r a vice astheprimary moniter...” we
can't handle twofull-res screens.) | Festend mp Windows desktop oto the mentor=
While you're at it drag the numbered screen icons|bio
to change how Windows “thinks” ofthem: beside9fo-20-o- enoldently J | Trou
one another, or even stacked vertically. The edge
they have in common is where your cursor can fiy
off screen #1 and reappear on #2.

 
' Advancedsettings

If you click the Advanced button on the Settings tab, you're offered a collection of
technical settings for your particular monitor model. Depending on yourvideo driver,
there may be tab controls here that adjustthe refresh rate to eliminateflicker, install an

- updated adapter or monitor driver, and so on. In general, you'll rarely need to adjust
~ these controls—except on the advice of a consultant or help-line technician.

 

 

Folder Options

This program offers three tabs—General, View, and File Types—all of which are
described elsewhere in this book.  

 

CHAPTER $8: THE CONTROL PANEL 0.05205 275

HP Inc. - Exhibit 1007~Page289. 



HP Inc. - Exhibit 1007 - Page 290

Fonts

This icon is a shortcut to a folder;it’s not a program.It opens into a windowthat
revealsall of the typefacesinstalled on your machine,as described in Chapter 13.

Game Controllers

Ifyou're a serious gamer, the Game Controllers program may interest you. You useit
to configure and control the joysticks, steering wheels, game pads,flight yokes, and
other controllers you've attached to your PC.After all, ifyour joysticks and controllers
aren’t installed and configured properly, you can’t pulverizealiens to fuil capacity.

To getstarted,install the driver software that came with your gaming device. If it’s a
modern, USB, Windows XP—compatible gadget, you may not even need to do that
much,Just plug in the device and watch the notification area for a message that Win-
dows XP has detectedit andinstalled the correct driver. (See Chapter 14 for more
on installing gadgetry.)

Next, open the Game Controllers program, where you should see the newly installed
controller listed. Click it and then click OK.If your device isn’t listed, click the Add
button. In the Add Game Controller dialog box, specify the kind of controller you
intend to install—“Gravis GamePad Pro (GamePort),” “6-button joystickw/two POVs
and throttle,” or what have you, and then click OK.

Once you'veselected the device, highlightits namein the Controller list box and then
click the Properties button to test andset up its various buttons, wheels, and knobs.
 

 
Note: Game controllers generally work only in gamesthat recognize them—not within Windowsitself. That
USB steering wheelyou've installed, for example,will almost certainly work in yourracing car simulator game,
but don’t expect it to help you drive around the icons on your desktop.

 

 
internet Options
A better namefor this program would have been “Web Browser Options,” since all
ofits settings apply to Web browsing—and,specifically, to Internet Explorer. Its tabs
break down likethis:

» General, Security, Privacy, and Content. These tabs control your homepage, cache
files, and historylist. They also let you define certain Web pagesas off-limits to
yourkids. Details on these optionsare in Chapter 11.

* Connections. Controls when your PC modem dials; see page 316 for details.

+ Programs. Use these drop-down lists to indicate which Internet programs you
generally prefer for email, creating Web pages, and so on. For example, the email
program you specify here is the one that will open automatically whenever you
click an “email me!”link on a Web page. The checkbox at the bottom of the dialog
box warns Windowsto watch out for the day when youinstall a browser other
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than Internet Explorer. At that time, you'll be asked which program—lIE or the
new one—you want to use as your everyday browser.

+ Advanced. On this tab, you'll find dozens of checkboxes, most of which are useful
only in rare circumstancesandaffect your Web experience only in minor ways. For
example,“Enable Personalized Favorites Menu” shortens your list of bookmarks
over time, as Internet Explorer hides the names of Web sites you haven't visited
in a while. (A click on the arrow at the bottom of the Favorites menu makes them
reappear.) Turning off the “Show Go button in Address bar” checkbox hides the
Go button at the right of the Address bar. After you've typed a Web address (URL),
you must press Enter to open the corresponding Web page insteadofclicking a
Go button on the screen. And so on.

For a relatively coherent description of each checkbox, click the question-mark
button in the upper-right corner of the window and then turn on the checkbox
in question.

Keyboard
You're probably too young to remember the antique known as a typewriter. On some
electric versions ofthis machine, you could hold down theletter X key to typeaseries
of XXXXXXXs-—ideal for crossing something out in a contract, for example.

 

 
Figure 9-157
Haw fast do you want your keys to repeat?
This control panel also offers a Hardware tab,
but you won'tgo there very often. You'll use it

your keyboardorits driver. Repeatdelay:

LOG neinneenenntnrenent nnennenennne SHOEi

Repeat rate:

SHOW neereretecnica Bashltalepae Sesqetbterscargadgagee

Click here and hold down a key to léat repeatrate: wepret niannen tenant ben : ne

(testing. testing, one two theeeeeeeeeeeeteeces
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On a PC, every key behaves this way. Hold down any key long enough,andit starts
spitting out repetitions, makingit easy to type, “No WAAAAAY!”or“You go,grrrrrl!”
for example. (The same rule applies when you hold down the arrow keys to scroll |
through the text document, hold down the = key to build a separatorline between
paragraphs, hold down Backspaceto eliminate a word, and so on.) The Speed tab of
this dialog box (Figure 8-15) governs the settings.

+ Repeat delay. This slider determines how long you must hold down the key before
it starts repeating (to prevent triggering repetitions accidentally).

* Repeat rate, The second slider governs how fast each key spits outletters once the
spitting has begun.

After making these adjustments,click in the “Click here and hold down a key”test
box to try out the new settings.

+ Cursor blink rate. The “Cursorblink rate”slider actually has nothingto do with the
cursor, thelittle arrow that you move around with the mouse. Instead,it governs
the blinking rate of the insertion point, the blinking marker that indicates where
typing will begin when you're wordprocessing,for example, Ablinkrate that’s too
slow makes it more difficult to find your insertion point in a window filled with
data. A blink rate that’s too rapid can be distracting.

 
 Figure 8-13:

ifyou're a southpaw, you've probably realized
that the advantages ofbeing left-handed when
you play tennis or basebaif were lost on the
folks who designed the computer mouse. It’s
no surprise, then, that most mice are shaped
poorly for Jefties—but at feast you can correct
the way the buttons work.

 
 

 
  

2 Buttan configuration ee

/ berich plimary and secondary buttons6S» SefSct this check box to make the bulton on the =
| night the one you use for primary functions such
| as selecting and dragging.  
 
 - Beiblocickspeed

Fi Double-click the folder to test your setting.If the
fy | folder does nat cpen or closa, try using a slower ©”

2 i setting.
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- Mail
: Ifyou havethis item,it’s because you've installed Microsoft Outlook. The three but-
‘tons here offer direct access to the settings you need to teach Outlook about your
“email account.

- Mouse

: ‘All of the icons, buttons, and menusin Windows make the mouse a very important
= tool, And the Mouse program ts its configuration headquarters (Figure 8-13).

Buttons Tab
- This tab offers three useful controls: button configuration, double-click speed, and
“ ClckLock.

-° Button configuration
. This checkbox is for people whoare left-handed and keep their mouse on the left

side of the keyboard. Turning on this checkbox lets you switch the functions of the
right and left mouse buttons, so that your index finger naturally rests on the primary

-- button (the one that selects and drags).

Double-click speed
Double-clicking isn’t a very natural maneuver. If you double-click too slowly, the

“icon you're trying to open remains stubbornly closed. Or worse, if you accidentally
- double-click an icon’s nameinstead ofits picture, Windowssees your double-click as
~~ two single clicks, which tells Windowsthat you're trying to renametheicon.

The difference in time between a double-click and two single clicks is usually well
“> under a second, That’s an extremely narrow window,so let Windows XP know what
~ you consider to be a double-click by adjusting this slider. Theleft end ofthe slider
” bar represents 0.9 seconds, andtheright end represents 0.1 seconds. Ifyou need more
- time betweenclicks, move the slider to the left; by contrast, if your reflexes are highly
~. tuned (or you drink a lot of coffee), try sliding the slider to the right.
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Each timeyouadjustthe slider, rememberto test your adjustmentby double-clicking
thelittle folder to the right of the Speedslider. If the folder opens, you've successfully
double-clicked. If not, adjust the slider again.

 
ClichLock

ClickLock is for people blessed with large monitors or laptop trackpads who, when
dragging icons onscreen,get tired of keeping the mouse button pressed continually.
Instead, you can make Windows XP “hold down”the button automatically, avoiding
years of unpleasantfinger cramps and messylitigation.

When ClickLock is turned on, you can drag objects on the screen like this: 
1. Point to the item you wantto drag, such as an icon. Press the left mouseor track-

pad button for the ClickLock interval.

Specify this interval by clicking the Settings button in this dialog box.

2. Release the mouse button. 
The button acts as thoughit’sstill pressed.

3, Drag the icon across the screen by moving the mouse(orstroking the trackpad)
without holding any button down.

To release the button, hold it down again for your specified timeinterval.

Pointers Tab

If your fondness for the standard Windows arrow cursor begins to wane, you can
assert your individuality by choosinga different pointer shape.

Selecting a pointer scheme
Windows has many more cursors than the arrow pointer. At various times, you
mayalso see the hourglass cursor (which means, “wait; ’'m thinking”or “wait; I’ve
crashed”), the I-beam cursor (which appears when yourre editing text), the little
pointing-finger hand made famous by Microsoft’s advertising (which appears when
you point to a Web page link), and so on.

 
All of these cursors come prepackaged into design-coordinatedsets called schemes. To
look over the cursor shapesin a different scheme, use the Scheme drop-down list; the
corresponding pointer collection appears in the Customizelist box. Some are cute:
Dinosaur, for example, displays an animated marching cartoon dinosaur instead of
the hourglass cursor. Someare functional: The ones whose names include “large”
offer jumbo, magnified cursors ideal for very large screens orfailing eyesight. When
you find one that seems like an improvement over the Windows Default (system
scheme) set, click OK.

Select individualpointers
It’s worth noting that you don’t have to change to a completely different scheme; you
can also replace just one cursor. To do so,click the pointer you wantto change, and
then click the Browse button. Youre shown thevastarray of cursor-replacementicons
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: (which are in the Local Disk (C:}+Windows—Cursorsfolder), Click one to see what
“it looks like; double-click to selectit.

- Create your own pointer scheme
Once you've replaced a cursor shape, you've also changed the scheme to whichit

belongs. At this point, either click OK to activate your change and get back to work,
or save the new, improved scheme underits own name, so you can switch back to the
original when nostalgia calls. To do so, click the Save As button, name the scheme,
and then click OK.

ip: The “Enable pointer shadow” checkbox at the bottom ofthis tab is pretty neat. It casts a shadow on
- whatever's beneath thecursor, as thoughit’s skimming just above the surface of your screen.

 

 

Pointer Options Tab
: This tab offers a few more random cursor-related functions.

- Pointer speed
‘Tt comes as a surprise-to many people that the cursor doesn’t movefive inches when
- the mouse movesfive inches on the desk. Instead, you can set things up so that mov-
_ing the mouse one millimeter movesthe pointer one full inch—orvice versa—using
‘the Pointer speed slider.

It may come as even greater surprise that the cursor doesn’t generally moveproportion-
ally to the mouse’s movement, regardless ofyour “Pointer speed”setting. Instead, the

- cursor moves farther when you move the mouse faster. How much farther depends
on how youset the “Select a pointer speed”slider.

"The Fastsettingis nice if you have an enormous monitor,sinceit prevents you from
needing an equally large mouse pad to get from one corner to another. The Slow

“setting, on the other hand, can be frustrating, since it forces you to constantly pick
up and put down the mouse as you scoot across the screen. (You can also turn off
the disproportionate-movementfeature completely by turning off“Enhance pointer

_precision.”)

Snap Te
: A hefty percentage of the times when you reach for the mouse,it’s to click a button
in a dialog box. If you,like millions of people before you, usually click the default
(outlined) button—such as OK, Next, or Yes—the Snap To feature can save you the

effort of positioning the cursorbeforeclicking.

When you turn on Snap To, every time a dialog box appears, your mouse pointer
fumps automatically to the default button,so thatall you need to dois click. (And
to click a different button, such as Cancel, you have to move the mouseonlyslightly
to reach it.)
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Visibility
The optionsavailable for enhancing pointervisibility (or invisibility) are mildly useful
under certain circumstances, but mostly, they're just for show.

 
* Display pointertrails. Pointertrails are ghost images of your mouse pointer that

trail behind the pointer like a bunchoflittle ducklings following their mother.
In general, this stuttering-cursoreffectis irritating. On rare occasions, however,
you may find thatit helps locate the cursor if youre making a presentation on a
low-contrast LCD projector.

* Hide pointer while typing. Hiding the mouse pointer while you're typingis useful
if you findthat it sometimesgets in the way of the words on yourscreen. As soon
as you use the keyboard, the pointer disappears; just move the mouse to make the
pointer reappear.

+ Showlocation ofpointer when I press the CTRL key.ifyou've managedto lose the
cursor on an LCD projector or a laptop with an inferior screen,this feature helps
gain your bearings. When you press and release the Ctrl key after turning onthis
checkbox, Windowsdisplays an animated concentric ring each subsequent time
you press the Ctrl key to pinpoint the cursor’s location.

 
Hardware tab

The Mouse program providesthis tab exclusively for its Troubleshoot and Properties
buttons,for use when your mouse, orits driver, is acting up. Network Connections

This icon opens up into a window containingicons representing the various network
connections you've configured—for America Online, your Internet provider, your
network (the Local Area Connection icon), and so on. See Chapter 18 for details.

Network Setup Wizard
You use this wizard to share one PC’s Internet connection on a network, turn onfile

sharing, or share one printer with other PCs on the network.

Phone and Modem Options

You'll probably need to access these settings only once:thefirst time you set up your
PC orlaptop to dial out. Details in Chapter 9.

Power Options
The Power Options program manages the power consumption of your computer.
That’s a big deal when you're operating a laptop on battery power, of course, butit’s
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 : also important if you'd like to save money (and the environment) by cutting down
on the juice consumed by your desktop PC. 
 

“The options available in this program depend on your PC’s particular features.
‘Figure 8-17 displays the Power Options Properties dialog box for a typical laptop
“computer.

 
 

Power Schemes Tab
‘The Power Schemestab lets you select, change, or create power schemes. A power
scheme defines which components of your PC shut down since you last used your
keyboard, mouse, or processor. Muchlike a screen saver, power schemesare designed
to save power, but they offer a greater variety of tricks:

 

> Turn offmonitor. Your monitor goes dark, andits powerlight changes from green
. to yellow. 
» Turn off hard disks. The hard drives stop spinning. 
*System standby. The computer goes into standby mode, whichis similar to being

~ asleep. The monitor,fan, hard drive, and other components go dark andstill. (Only
. a trickle of electricity is required to keep alive what's stored in memory.) When you

press a key or click the mouse, the PC wakes upin less than five seconds, returning
“to the screen everything you were doing before the computer dozed off. (The one

 

 
 

Figure 8-17:
-: The Power Options program is a shape-shifter,
“meaning which set of tabs it has, and which
"controls are available on each one, vary from
“one PC to the next. Some of these tabs appear
“only ifyou have a laptop (or an uninterruptible
power supply). Others depend on how new
“othe PC is, and which version ofthe standard
-» power-managementcircuitry it contains,
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downside of standby mode:If the power goesout, you lose any unsaved changes
in the documents on the screen.)

* System hibernates. As described in more detail on page 27, a PC that’s aboutto
hibernate copies everything in its memory into a file on the hard drive (a process
that takes a minute or so). Then the computer completely shuts down, requiring
no powerat all. Even if the power goes out, everything you had open is safely
preserved,

Later, when you “awaken” the computer again (by pressing the power button),
you're returned to the same open documents and programs. Copyingall of this
information from the hard drive back into memorytakes 30 or seconds orso, but
that’s still a lot faster than the computer would have taken to turn on from its Off
condition.

 
Use the “Power schemes” drop-downlist to choose from Windows XP’s built-in
power schemes: Home/Office Desk, Portable/Laptop, Presentation, Always On, and
so on. Eachof these schemes calls up certain canned settings to match the situation.
For example:

 
* Home/Office Desk is designed for desktop computers. Thefactory settings put the

monitor into low-power modefirst, then the hard drive, then the computeritself.
(In other words,it goes into standby or hibernate mode.)

+ Always On puts your monitor and hard drive to sleep after ten minutes o¢ an hour,
but never invokes standby for the PC itself.

 
 

: Portable/Laptop puts the monitor, hard drive, and computer to sleep sooner than
the desktop schemes in order to save battery power. 

You're welcometo changethe settings for any of these schemes. Once you've done
so, click the Save As button to preserve your new settings under a new scheme name.
Finally, click OK to close the Power Options Properties dialog box andactivate the
selected power scheme,

Tip: You might want to set up your power schemeso that the PC goes into standby modeafter, say, ten
minutes, and then hibernates after 30. That way, if you're only away from your desk for a minute, you can
get back to work immediately—butif you get called away longer, or even overnight, everything that was open
on the screen is safe—and you're notusing electricity while you're away.

 

Waking up your PC
To bring your computer out of standby mode,just move the mouseor press a key. The
PC can wakeitself up, too, when you've programmed something to happen (such as
setting up your email program to check for new messages) or when a fax call comes
in (if you've set up your PC to receive faxes). Whenthetask or the phone connection
ends, the computer returns to standby automatically.
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: To bring the computer back from hibernation, you generally have to press the power
_ key.

_» Alarms and Power Meter Tabs: For Laptops
“’ Notebook computers offer additional power options, which help them conserve power

- when running on batteries.

» Alarmstab

When yourbattery starts running outof juice, your laptop displays a warning mes-
“gage. When there are only a few secondsofpowerleft, you get another, more urgently

: worded message. Both messages are designedto alert you that now is a good time to
“save whatever document you've been working on; the laptop is about to go to sleep
“until you've plugged the power cord into the wall.

‘The controls on this tab let you specify when (or whether) these messages appear,
_ what kind of notification you want (a message, a sound,or both), and what the laptop
does as a result (such as going into standby mode),

‘Power Meter tab

‘This tab is your laptop battery’s fuel gauge. If your computer has twobatteries, turn
von “Show details for each battery.’ Youll see an icon for each battery, which slowly
“empties” as your power runs down.

“Advanced Tab
. The “Always show icon on the taskbar” option putsa tiny power-plugicon (orbattery
‘icon,ifyou're using a laptop that’s unplugged} in the notification area of the taskbar.
Click this icon to produce a menulisting the power schemes you've established (see
‘page 284), makingit easy for you to switch among them. Andifyou right-click this
icon, youre offered commandsthat take you directly to the Power Options program
orits Power Meter tab.

I€ you select “Prompt for password when computer resumes from standby,” you're
-asked to enter your login password(ifyou have one—see Chapter 17) each time you
‘awaken the computer. That’s handyprotection when you wanderaway from the desk

: for some coffee or a candy bar. 
: Tip: Despite the name of this checkbox, Windows XP also demands a password in order to awaken from
‘fibernation: mode (not just standby). 

   

 

 
 
 

 

“Onsome PCs,this tab containsa third option, whichlets you specify what happens
-whenyoupress the power button on your computer. You mayprefer that the power
button put your computer into standby or hibernate modes,instead of turning the
‘computeroff. This feature is an ingenious hedge against a potentially disastrous situ-
_ation: The computeris in standby modebut, uponseeing that your monitoris dark,
you assumethatit’s turnedoff. You hit the power button to turn it on—butactually
‘cutthe power, obliterating any unsaved documents and possibly causing otherfile
damage.
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Tip: If you've assigned the powerbutton to the Standbyor Hibernate functions, you can stiil use it to turn
off the computer completely. Just hold the button downfor a few seconds. 

Onalaptop, you can choose two different sets of settings, one for when the laptop
is plugged in and one—presumably a more power-stingy configuration—for when
it’s running on batteries.

Laptops mayalso let you specify what happens when youclose thelid (standby, hi-
bernate, or do nothing) or press the sleep button (standby, hibernate, shut down,do
nothing, or ask you what to do).

 
Hibernate Options
Ifyou have a Hibernate tab—whichislikely, since most computers young enoughto

_ run Windows XP are also young enoughto includethisrelatively recent feature--you
can useit to set up the hibernation feature (see page 27}. Turning on “Enable hiberna-
tion” doesthe following: 

* The Power Schemes tab displays a new power-scheme option called System Hi-
bernates. Now you canspecify the durationofidle time before your PC hibernates
automatically. On someolder PCs, you may not see the System Hibernates option
until you turn on the “Enable Advanced Power Management Support” checkbox
on the APM tab.

* The Shut Down dialog box (Start->Turn Off Computer) displays a Hibernate
option (in addition to Shut Down and Restart). See page 27 for details.
 

Mote; Because the hibernation feature saves everything in memory asafile, it consumes a lot of disk
space~in fact, as much disk space as your PC has RAM. (Note fer techies: When the PC hibernates, it copies
everything that was in RAM intoafile on the hard drive calied Miberfilsys.)

The Hibernate tab displays the amountof free disk space, along with the amountof disk spacethat’s required
for the PC to hibernate.

 
 

Troubleshooting Standby and Hibernation
Both standby and hibernation modes can cause glitches. For example: 
Standby doesn’t save data
When your computer is in standby mode, any unsaved documents on the screen
remain unsaved.In fact, your computeris in the samestate it would be ifyou walked
away without using standby; the only difference is that the PC is consuming less
power. During hibernation, by contrast, everything in memory—thatis, everything
on the screen, including all open documents and programs—issaved to a file on
your hard drive.

If you shutoff the computer, or if powerfails, any documents you forgot to save are
gone forever. Therefore, it’s a good idea to choose File-»Save for any documents
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